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Chapter 1. Introduction

The PROCOM software allows you to control one or more PROCOM controllers. This manual explains how
the software and the controller work together and guides you from installation of the software through basic
setup to configuration and day-to-day usage of the system.

1.1. Features

The PROCOM is an advanced, computer controlled irrigation controller that will manage up to 500 valves
distributed over up to eight miles of water pipe. The communication between the controller and the decoders
that control the valves in the field happens over a two-wire path - more on this in Section 1.2, “The Two-wire
Technology” [page ?]. The PROCOM software lets you manage one or more controllers from your PC.

Here are a few selected features of the PROCOM that can be controlled from your PC:
» Creation of irrigation schedules.

 Creation of a layout map for the hydraulic grid of pipes through a graphical interface.
» Configuration of booster pumps and decoders (valves).

 "Installation Data" and "User Data" protected by separate passwords - more on the distinction between
the two in Section 1.3, “PROCOM Concepts” [page 2].

 All settings and configurations are transferred directly to a controller via a COM port on your PC, or
remotely via a modem.

* Tests of both the two-wire and remote decoders can be performed directly from the PC.

All settings are handled via the software - the controller itself has no controls on the cabinet. This means
that even if your controller gets damaged, you can continue running your irrigation schedules - just transfer
all your settings and schedules to a replacement controller and you're ready to go.

2 Important
Since the PC is the authoritative source of all configuration data, you should back up the settings
after initial setup and after any changes you make to your system (See Section 6.2, “Backing
up your Installation” [page 135] for instructions).

1.2. The Two-wire Technology

The PROCOM uses two-wire transmission technology to tell the field decoders when to act. This means
that instead of laying out a wire to each individual valve, just one single wire is laid out, and the field decoders
all connect to the same wire:
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PROCOM Concepts

PROCOM

In contrast, this is how the above system would look using a conventional irrigation system that needs a
dedicated wire to each individual valve:

Controller i

The two-wire technology has several obvious advantages over a conventional system:
» Ease of installation: You avoid the hassle of turning your park into a mess, digging in wires everywhere.

» Ease of expansion: When you need to add a decoder in the field, you don't have to dig in a new wire and
risk damaging the existing web of wires already in the ground - you simply attach the new decoder to the
existing wire.

» Cost reduction: You save loads of money on expensive copper wire - typically as much as 80 percent
compared to traditional cabling.

1.3. PROCOM Concepts

This manual refers to two different types of settings and configurations - "Installation Data" and "User Data".
Since there's a distinct difference between the two, they each have their own chapter:

Installation Data (Chapter 3, Installation Data - Setup Guide [page 17])
Installation data is all about the available resources at a site. This is where you tell the controller about
pipes, valve types, decoders, pumps and sensors. The installation data forms the basis of what you can
do with your irrigation schedules - the schedules are utilizing the resources declared in the installation
data.

Often the installation data are set up by the people setting up the physical irrigation system, since they
know how the system is designed. The data is then left untouched and password protected until a change
of the physical installation takes place.
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Behavior of the PROCOM Software

User Data (Chapter 4, User Data - Day to Day Usage [page 39])
User data is what controls the day-to-day usage of the system. Based on what hardware is available,
as described by the installation data, this is where you build your irrigation schedules and transfer them
to the PROCOM controller.

1.3.1. Behavior of the PROCOM Software

This section contains a few brief notes on how the PROCOM software works in general.
1.3.1.1. Icons in System Tray

When the software is launched, two icons appear in the system tray:

These icons represent the two main components of the software: the "Control Server" and the "Database
Server". These icons are your indication that the software is running.

@ Note
When you close down the software, the icons will stay in the system tray for about 20 seconds,
so don't worry that you haven't closed the software correctly when the icons don't disappear
immediately.

1.3.1.2. Different Password Levels
The PROCOM allows to granulate the access to it's functionality through different levels of passwords.

By default all passwords are blank, but you can change them on both user and installation level. Access
the installation level should be limited to the people setting up the system, defining pipes, pumps, decoders
etc, whereas access at the user level should be granted to the people working with the system on a daily
basis.

Both user and installation level passwords can be set per site, and if no site is selected, a few general
settings can be accessed with the system wide user and installation passwords.

The table belows summarizes what can be done at the different levels.

User Level Installation Level
No site selected * Select Site + Parameters
¢ Phone Book » Change Password

¢ Select COM Port

< Extract and view monitor log
« View monitor log

¢ Extract monitor log

¢ Change Password

Site selected ¢ Connect to Controller ¢ Site Parameters
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Behavior of the PROCOM Software

User Level Installation Level
« Irrigation Schedules » Change Installation Password
« Manage Sectors » Delete all Data
e Change Pump Status » Erase Sensor Decoder Data
« Change Sensor Status . Manage
e Manual start of Wﬂm

Decoder/Schedule
» Set Date/Time on Controller
* Change User Password
* Use Test Functions
* Weather Station Functions

« Change Irrigation Status

As a rule of thumb everyone will have read access to everything, but the passwords are needed at the
different levels if you want to change anything.

The User Passwd and Inst. Passwd buttons in the main window will be green or red depending on what
level of access you have. A couple of examples:

Connected to the SIENNA site and online. User access but no installation access:

PLITE [007 - SIENNA]

System  Irrigation  Manual  Setup Yiew  Help

EE o] (Ot | _vow e | RG] |

Connected to the SIENNA site and online. Full access:

BB ProCom - [001 - SIENNA] CEX

Systern  Irrigation  Manual  Setup Yiew  Help

| 2] o] Ondine | _User posowd | tust Pasewi | |

Not connected to a site. User access but no installation access:

kR ProCom - [- [No Active Site]] M=1E3

System Setup  Yiew Help
EEE | ] s pv | ] |

To toggle the access level, click the buttons - if you go from red to green you will be prompted for the
appropriate password. If the password fields are grayed out, the passwords are still just blank. To change
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Behavior of the PROCOM Software

the passwords, follow the instructions in Section 4.3, “Setting the User Level Password” [page 44] and
Section 3.1.3, “Password” [page 21].

1.3.1.3. Dialogs

The PROCOM software operates with non-modal dialogs. This means that you don't have to close windows
in backwards order of how you opened them - you can shift freely between all open windows and work with
the data in each one in any order you like:
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This flexibility means that the data you enter in a dialog is saved as soon as you leave the field you've
entered the data in - an important difference.

2 Important

Due to the non-modal design, you can't just close a dialog and "forget about the changes" - all
changes are saved when the cursor leaves the field that holds the data.

173-230-0001/B 5






Chapter 2. Installing the PROCOM

2.1. Installing the software

The PROCOM software runs on Microsoft Windows 2000 and Windows XP operating systems.

You can install the PROCOM software independent of the hardware it will be controlling, meaning that you
can install the software and start mapping in your hydraulic system, creating irrigation schedules and so
forth without being connected to a physical controller.

2.1.1. Running the Installer

Your PROCOM software comes as a standard Windows installer - you should be able to just put in the CD
and follow the instructions, but here's an explanation of the steps involved:

1. Putthe CD in your CD-Rom drive and wait for the installer to pop up. If it doesn't happen automatically,
navigate to the CD in the Windows Explorer and double-click the Setup.exe icon.

Before the installation starts, your computer is scanned for any previously installed version of this
software - you might see this for a few minutes, depending on the configuration of your machine:

g Setup iz zearching for ingtalled components. ..

After the scan is over, you'll see the following welcome screen:

Welcome E|

“welcome to the TUCOR ProCom BMS Setup
program. T hiz program will install TUCOR ProCom
= RS on vour computer.

It iz strongly recommended that you exit all \Windows programs
before running thiz Setup program.

Click Cancel to guit Setup and then cloze any programs pou
hawve running. Click Mest to continue with the Setup progranm.

WARMIMG: This program iz protected by copyright law and
internatianal treaties.

|Inautharized reproduction or dizgtribution of thiz pragram, or ang
portion of it, may result in severe civil and ciminal penalties, and
will be progecuted ta the marimum extent poszible under law,

Memt » | Cancel
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Running the Installer

Just click the Next button here.

2. The next step is just to fill in your name - this has no effect on the way the software will work:

User Information El

Fleaze enter pyour name and the name of the compary for whom
yoLd ik,

Mame: |.J|:|hn Do

Company: |"r’u:uurEu:ur|:u. I

< Back | M et » | Cancel

Fill in your name and click Next.

3. Now you're prompted for where the software should be installed. If you have any specific requirements
to this, select the desired location by clicking the Browse... button and selecting a folder. If you're OK
with the default, just click Next:

@ Note
If you're upgrading an existing installation, we recommend installing in a fresh directory.
See Section 2.2, “Upgrading from older versions” [page 16] for more on upgrading.

8 173-230-0001/B



Running the Installer

Choose Destination Location

Setup will ingtall TUCOR ProCom BRS in the following folder.
Toingtall bo this folder, click Mesxt.

To inztall to a different falder, click Browse and select anather
folder.

Y'ou can chooge not to install TUCOR ProCom RS by clicking
Cancel bo exit Setup.

— Destination Falder

C:5Program Filesh\TUCOR PraCom RMS Browse...
¢ Back | Memt > | Cancel ‘

The next step is asking you for the "Program Folder" to put the Tucor software in. This determines
where the application will show up in the program listing - you should be fine with accepting the default:

Select Program Folder El

Setup will add program icons to the Program Folder listed below.
You may tpe a new folder name, or zelect one from the existing
Folderz list. Click Mest to continue.

Frogram Folders:

TUCOR FraCom RS

Exizting Folders:

Administrative Toolz
Fames

iTunes

bicrosaft Qffice
tazilla Firefox
tozilla Thunderbird
k51

Flone

[:>

£

¢ Back | M et » | Cancel

That's it, the installer will transfer the files to your machine. Again, this might take a few minutes,
depending on your configuration.

173-230-0001/B 9



Entering the Software License Key

When the installation is all finished, you'll see the following screen:

Setup Complete

Setup haz finizhed instaling TUCOR ProCom BkS an paur
computer.

Setup can launch the Read Me file and TUCOR ProCom Rk 5.
Choose the options you want below,

v ez | want bo view the Beadme File

LClick Finizh to complete Setup.

| Finizh |

You're encouraged to review the README file as suggested, but you can move on to Section 2.1.2,
“Entering the Software License Key” [page 10] to start using your Tucor software.

2.1.2. Entering the Software License Key

Before you can start using your PROCOM software you need to enable it by entering a license key. Later
you will need a separate key for each controller you wish to communicate with. Keys are obtained from
Tucor and the procedure is explained in Section 2.1.3, “Entering Controller License Keys” [page 11].

To enable the software, follow these steps:

1. Launch the PROCOM software by opening the start menu and selecting All Programs > TUCOR
ProCom RMS > ProCom

This is assuming that you're running Windows XP and that you didn't change the Program Folder when
running the installation described in Section 2.1.1, “Running the Installer” [page 7].

2. Since your software is not yet unlocked the startup sequence will be halted and you'll be prompted for
a license key:

10 173-230-0001/B



Entering Controller License Keys

EZ{ Registration V 1.8

Company |

Uzer Mame |

Address |

City

State

|
|
Tip Code |
|
|

Req. Mo |

Load | OH| Canu:el|

3. Push the Load button to open a file chooser - this will let you locate your registration file and load the
registration data automatically.

Alternatively you can type in the registration details manually, though this is more error prone.

2 Important
The registration data is case sensitive.

4. Push the OK button.

If the registration data are valid, your software is now unlocked and you can launch the application
again without being prompted for registration data.

Now the software is unlocked and you can start editing a few basic settings. However, before you can start
building configurations for real sites, you need to enter a license key for each site in question. This is described
in Section 2.1.3, “Entering Controller License Keys” [page 11].

2.1.3. Entering Controller License Keys

For each site/controller you wish to control with the PROCOM software, you need to enter a license key.
License keys are obtained from Tucor and come as either plain text information you can enter manually or
a registration file you can point the software to.

Site licenses are managed in the "Phone Book" - to enter a key, follow this procedure:

173-230-0001/B 11



Entering Controller License Keys

@ Note
You can start configuring your PROCOM even though you don't have a valid license key yet -

1.

2.

you just can't connect to the controller and transfer the settings.

Launch the PROCOM software:

fi ProCom - [- [No Active Site]]
Marual Setup Wiew  Help

E - Uszer Pazawd | Inat. Pazswd I

TUCOR INC.
DEMO

518 WALLACE ROAD
WEKFORD

51090

Pa,

PROCOM

| Off Line

Most menus are greyed out since no site is active and thus only limited configuration is possible.

Open the System menu and select Phone Book:

12
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Entering Controller License Keys

R ProCom - [- [No Active Site]] A

W= rigation Manual Setup Wiew  Help

Select site _ [:'ﬁhl - User Paszzwd | Inst. Paszswd I
Select COM Part g

eisinload T Software

Exit

TUCOR INC.
DEMO

518 WALLACE ROAD
WEXFORD

51090

PA

PROCOM - =

Edit phone book | Off Line

Now you'll se the empty phone book:

I Phone Book

| Id | Account | Site Phone |No nfvalves{ License | =
0

Type in an account name, site name and phone number. When entering the Phone column, a helper
dialog will pop up:

173-230-0001/B 13



Entering Controller License Keys

Select COM Port for direct connenction, or Modetn for remote connection.

=elect Service ComPort
COM - Communications Port (Standard port types)

COME - Kevspan USH Serial Port (Keyspan)

COME - CP2101 USE to UART Bridge Controller (Silicon Laboratories)
COMI - PCI Communications Port (Enhanced portz)

COM3I - USB-o-Serial Port Driver (MosChip Semiconductor Technology)
COMA O - Yirual IR COM Port (Jan Kiszka)

COM11 - USB-o-Serial Port Driver (MosChip Semiconductor Technology)
COh 2 - ATEM IISE to Serial Bridge (ATERN)

Modem - Enter Phone # below

)

i DR R B B B B

When choozing Modem, enter the phone number of the controller.

If you're connecting directly to the controller, select one of the available COM ports. If you're using a
modem, select Modem and enter the phone number below.

@ Tip
If you're behind a switchboard or need to wait for a dial tone, you can use commas to make
the modem wait for a little while before dialing (i.e."9,,,,61789034").

2 Important

You must enter the account name before anything else - only when an account name is
entered is the database ready to store the remaining data.

If you're having problems connecting to a controller, check out Section A.1, “Troubleshooting the
connection” [page 137] for help.

14
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Entering Controller License Keys

Now click in the "License" field, and you'll be prompted for the licensing information:

i Registration of controller, E”E| rz|

Company |

Uzer Mame |

Address |

City

State

Zip Code

Decoder no.

Westher =t [

Setial mo. |

Redq. Mo |EI

Ok | Load Cancel

Click the Load button to locate a registration file or type in the data manually - then click OK.

2 Important
The registration data is case sensitive.

The "No of valves" field will be filled in automatically depending on how many valves your license allows.
If the license information is approved, you'll end up with a phone book looking something like this:

B Phone Book |:]|E|E|
iy
| Id | Account Site Phone |No ufvalves| License | =
1 Claus’ Account | 50 [0k |

o
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Upgrading from older versions

Type in a name for your site and you're ready to select a site and start configuring.

2.2. Upgrading from older versions

Upgrading the PROCOM software is pretty a straight forward process:

1. Install the new software in a directory different from the one containing the old installation. (Example:
Your original copy was installed in C:\ Program Fi | es\ ProCom- install the new software in C:\ Program
Fi | es\ ProCon®).

2. Copy the following files from the original installation to the new one:
e procom | db
e nonitor.ldb
* ProconRMS. i ni

3. Now double-click the upgrade script called upgr adedb. bat in the new installation folder, and the PROCOM
database will be upgraded to run with the new software.

g Note
If you're installing on top of an existing installation (installing in the same location), the
installer will automatically run upgr adedb. bat for you. However, we recommend never to
overwrite an existing installation.
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Chapter 3. Installation Data - Setup Guide

To configure the Installation Data for a site, follow this procedure:

@ Note
You can start entering installation data even if you don't have the license key for the controller
you need to transfer the data to. Only when you actually perform the transfer is the license key

needed.

1. Select a site to configure, as described in Section 4.1, “Selecting a site” [page 39].

2. Open the Setup menu and select Installation Data:

il ProCom - [Permanent Staff - East Bay]

Sl Wiew  Help

m M - Uzer Pasawd | Inst. Passwd I
Date and Time

Passward
Test k
Weather Skation  »

Swstem  Irrigation  Manual

=]

TUCOR INC.
DEMO

518 WALLACE ROAD
WEKFORD

51090

P,

Start edit of Installation Data | Off Line

This will open a new window from which you'll configure the Installation Data:

173-230-0001/B 17



Setup

f& ProCom - Installation Z E|[Z|
Setup  Pipes Walves Pumps Sensors  Test
| [
-
=ection 1(500.0 B
MWain Pipefs00.0)
Section 2(500.0)
bt
5 r

What you see in this window is the grid of pipes in the selected site.

The following sections describe each menu option in turn.
3.1. Setup
This section contains explanations of a few very high level settings in the system.

3.1.1. Parameters

1. Open the Setup menu and select Parameters:

ﬁ ProCom - Installation Z E|[Z|

CWlaM Pipes  Valves Pumps  Sensors Test

Site parameters k

Passwiard

Section 1(600.0
Delete all data L ection 1( ) -

Erase sensor decoder

[

Printer setup
Prink Prewview
Section 2(500.0)

Prink

Close

[ %

< |
Edit the Installation Data

|
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Site Parameters

This opens the following dialog:

System name
Max . number active Solenoids (Per Elec. Section)

ER

Type legal characters (max. 15)
| 1234567 530BLSGD

Select measurement units

m3, m3h, 1M0 mm and mmh
I, bmin, 140 mm and mmh

Gal's, gpm, 1100 inch and inchih

2. The parameters are:

System Name
A label for the system that will shop up in the title bar of the main window. If you're a contractor
running multiple PROCOMs for clients off of several installations of the PROCOM software, it's nice
with a label to distinguish the installations.

Max. number of active solenoids
The maximum number of valves that can run simultaneously in each electrical section. This is used
by the flow management mechanisms and you must make sure that your hydraulic system has
enough capacity for this many valves to run at once. Enter a value between 1 and 20 (the PROCOM
can run up to 40 decoders simultaneously, but only if they are distributed on two different wires -
see instructions on how to add a new pipe for details on electrical sections).

Legal Characters
List of valid characters to use with the Field Access Unit (FA/RFA).

Measurement units
This is the units used to enter values throughout the system.

2 Important

If you change this later on, entered values will not be converted, so make sure to pick
the right scale once and for all, or the data can be misleading.

Type in your settings and click the OK button.

3.1.2. Site Parameters

1. Open the Setup menu and select Site parameters:
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Site Parameters

2.

CEX

ﬂ ProCom - Installation

Pipes Walves Pumps Sensors

Setup

Parameters

Password k e

Delete all data EiL
Erase sensor decoder

Printer setup
Print Preview
Prink

Close

% | >

Edit site specific parameters

This opens the following dialog:

X]

Site Setup

Powver Fail Definition Walve Stop Delay
Time between a Valve Stop Command

and next Valve Start

= (0 - 30 seconds)

Irr. Schedule will continue WHERE it stopped

If Power Off Time is less than

1 {Hours}

Should the power failure last longer than indicated
Irriggation will cortinue &t the point where it wwould
be in real time when the power comes back, ie.
you swill miss irrigation during the pover failure but

Caution: “ou should be aware that the "Walve Stop
Delay" can create some difficulties in interpreting
the monitoring data shown in the Logviewwer. =oin
general it may be hest to keep the delay as short as

the schedule will finish at the time expected. possible.

Power Fail Definition
The Power Fail Definition allows you to set a time limit for how long a power failure should be able
to delay irrigation.

Say you set the limit to one hour. If the power fails and return after 45 minutes, the irrigation will
resume where it was abrupted, thus pushing the end time 45 minutes back. If this causes an overlap
with one or more following schedules, these will not be started.

If you set the limit to one hour and the power fails for more than that, irrigation will pick up where it
would have been, had there been no power failure.

20
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Password

So, in short, you need to determine how much you can "afford" to delay irrigation in the case of a
power failure.

Valve Stop Delay
Putting a delay between stopping a valve and starting the next can be helpful to ensure that you

don't run more valves than intended, which can lead to too much pressure in the pipes and potentially
damage your pumps.

Once done, click the exit button.

3.1.3. Password

Follow this procedure to set the installation level password for this site. (Check out Section 1.3.1.2, “Different
Password Levels” [page 3] for more details on passwords.).

1. Open the Setup menu and select Password:

ﬂ ProCom - Installation |Z|E|E|

= 0e Pipes  Valves Pumps  Sensors

Parameters
Sike parameters

| ¥

Delete all data EiL
Erase sensor decoder

Printer setup
Print Preview
Prink

Close

% | >

.E.rﬁerfE"dit .the Insiallatinn FPassword

This opens the following dialog:

i Password Definition [g

Type current Password
Type Mewy Password

Type Mewve Passward AGAIN

il

Vo Cancel
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Delete All Data

2. Type in the current password in the first box, followed by the new password repeated in the next two
boxes and click the OK button.

@ Note
When you start using the software the password is blank, so to set the password, leave
the "Current Password" blank, type in your new password in the two following fields and
click the OK button.

3.1.4. Delete All Data

This procedure will permanently delete all installation and irrigation data for the site you are logged in to.
You would never do this on a running system, but it comes in handy if you have just been playing around
with the features of the software and want to start over from a clean slate.

o Warning
There is no option of undoing this action, so show caution before performing this procedure.

1. Open the Setup menu and select Delete all data:

ﬁ ProCom, - Installation

SN Pipes  Valves Pumps  Sensors

Patarmeters
Site paramekers
Passward he

Erase sensar dec!gr

Printer setup
Prink Presview
Prink

Close

X | #

.Ijelete all défa, hntﬁ Installatilﬁn Déta and User Data

This opens the following dialog:
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Delete Sensor Decoder

Confirm

7 E DRAFT Tix BE ERASED ¥
L

Yes Mo ‘

2. Click the Yes button to delete all data, or the No button to abort.

3.1.5. Delete Sensor Decoder

This procedure erases setup data for all sensor decoders in the current site.

O Warning
There is no option of undoing this action, so show caution before performing this procedure.

1. Open the Setup menu and select Erase sensor decoder:

E_i ProCom - Installation IZIIEIEI

ECWlel Pipes  Valves  Pumps  Sensors

Parameters
Site parameters

[

Passward

Delete all data 513

Erase sensor decoder

Printer setup
Prinkt Presview
Prink

Close

154

< | >

Erase all sensor decoder set-up

This opens the following dialog:
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Pipes

\:":j Erase all sensor decoder setup?

o |

2. Click the Yes button to delete all sensor decoder data, or the No button to abort.

3.2. Pipes

The grid of pipes is what you see when you first open the window to modify installation data:

E_i ProCom - Installation

Setup  Pipes Yalves Pumps  Sensors  Tesk
e e
-
Section 1(500.0)
Main Pipe(s00.0) T
section 2060000
b
< &

To edit the existing pipes you can simply click them in the graphical overview. The two following sections
describe in detail how you configure the pipes.

3.2.1. Main Pipe

To configure the main pipe follow this procedure:

1. Open the Pipes menu and select Main Pipe:
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Main Pipe

E_i ProCom - Installation |Z”E”E|

Setup Bals==0 Yalves Pumps  Sensors  Tesk
| Mew Pipe
Sectio r bt
b
£ ! *
Set the Main Pipe Section Flow

This opens the following dialog:

hlain Pipe

Capacity
S00.00 Gpm

Slave Pump

uze O for none

Electrical Section

[0ar1)

Pump Capacity load Factar

—

| El
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New Pipe

2.

3.

3 Note
You can also open this dialog by double clicking the pipe in the graphical view of the pipes
on the site.
Fill in the Capacity property:

How much water can this pipe transport per time unit (measured in gallons per minute or cubic meters
per hour, depending on how you configured your installation.

S Note
The rest of the fields are dimmed out here because they don't apply to the main pipe - only
to subsequent pipes connected to the main pipe.

Click the exit button to save your settings and close the dialog.

3.2.2. New Pipe

1.

Open the Pipes menu and select New Pipe:

ﬂ ProCom, - Installation

Setup Mae==M Yalves Pumps  Sensors  Test

E!_ |' MaiﬁF‘ipe
Sectin r b

X | 2

Define a new Fﬁpe Section and set the flow

This opens the following dialog:
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New Pipe

Pipe zection 3

Capacity
0.00 Gapm

Slave Pump

0 | uselfor none

Electrical Section
0 [0ar1)
Pump Capacity load Factar

i

Connected to

|ru1ain Pipe ﬂ

on the site:

Fi ProCom - Installation

S Note
You can also open this dialog by double clicking the pipe in the graphical view of the pipes

EEX

Setup  Pipes  Walves Pumps  Sensors  Tesk
|
ks
Section 1(500.0)
Main Pipe(500.0) 0
Section 2(500.0)
b
< X
2. Fill in the following properties:
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New Pipe

Capacity
Amount of water this pipe can transport per time unit (measured in gallons per minute or cubic
meters per hour, depending on how you configured your installation).

Slave Pump
The slave/booster pump associated with this pipe. The selected pump will be activated whenever
a valve is opened on this pipe or any of its connected pipes.

Electrical Section
You can declare two electrical sections in a system - connect two two-wire paths to the controller
instead of just one to avoid maxing out the capacity of the cable. In this field you tell the controller
which electrical section (which cable) the pipe (and its decoders) is connected to, and the controller
will then take this into consideration when performing flow management.

Pump Capacity Load Factor (optional)
If the pipe is running up/downhill you may adjust the pump load factor accordingly. This is easiest
understood by looking at a scenario:

Suppose the booster pump activated for this pipe can maintain a pipe pressure of 100 PSI while
delivering 400 GPM. If the pipe elevates 60 feet, the pressure drops 30 PSI. To maintain the pressure
at 100 PSI at the top of the hill, the pump must then deliver 130 PSI at the foot of the hill, meaning
that the GPM will drop to 333 - the graph below illustrates this relationship:

PSI A

150

130 F-——==——m =

100

w_____________—___

w
In
S
\ 4

o

200 GPM

The pump capacity load factor is then calculated as: 400/333 = 1.2. When you type in the value,
leave out the decimal - 1.2 becomes 12, 1.0 becomes 10 etc. Valid values are between 1 and 99.

Flow management then uses this number to calculate how many fewer valves can be open on the
pipe while pressure is maintained.

Connected to
Select the pipe that this pipe is connected to.
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Valves

3 Note
Main Pipes won't appear as connected to anything - only "sub pipes" can connect.

3. Click the exit button to save the new pipe and close the dialog.

3.3. Valves

There are two steps to configuring the valves in the system and this section explains how to manage both:

1. Describing the different valve types in your system is explained in Section 3.3.1, “Types of
Valves” [page 29].

2. Configuring the individual valves, based on type is explained in Section 3.3.2, “Line Decoder” [page 30].

3.3.1. Types of Valves

Before you can add valves to your system you must define which valve types you are using - this is a handy
way of not re-entering the data for each valve. Once you've defined the types of valves, adding a single
valve is just a matter of telling the system which type it is, and the system will know how to treat it.

To manage the various types of valves used in your system, follow this procedure:

1. Open the Valves menu and select Type of valves:

ﬁ ProCom, - Installation

Setup  Pipes WIEIEEN Pumps  Sensors Test
- [
_E-J o Line Decoder %i
Section &(0.0F . L
¥
L5 ! L.
Define and Modify “alve Types

This opens the following dialog:
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Line Decoder

@

2. Now you must fill in all the columns of the grid, describing a valve on each line:

Id
The ID of each valve type is determined by the software - you shouldn't fill anything in here. You
will need to know the ID of the valve types when you have to configure the individual decoders.

Capacity
The flow capacity in the system unit selected in Section 3.1.1, “Parameters” [page 18] - Gallons or
Liters per Minute.

Applic. Rate
How much water should be applied per time unit? The units can be inches per hour or millimeters
per hour depending on how you set up the system wide parameters (described in Section 3.1.1,
“Parameters” [page 18]).

Resistance
The resistance in the coil on the solenoid. The unit here is Ohms, and though not mandatory, you
should always supply this data as it will help the PROCOM function more correctly.

If the resistance is set between 1 and 50 Ohms, the PROCOM will automatically check that the
solenoids are activated correctly.

Switch
This is the switch code used to control the solenoid - please see Appendix B, Switch Codes [page 139]
for a complete reference.

No Solenoids
The number of solenoids attached to this valve. Flow management uses this number calculate
capacity and power consumption.

Description
This is a free text area you can use for your own descriptive purposes. You have 200 characters
available.

3. Click the exit button to save your settings and close the dialog.

3.3.2. Line Decoder

This procedure describes how you define the individual line decoders that will activate valves in the field.
Before you can do this, you must define the types of valves in your system as described in Section 3.3.1,
“Types of Valves” [page 29].

1. Open the Valves menu and select Line decoders:
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Line Decoder

E_i ProCom, - Installation

Setup  Pipes WIEIEEN Pumps  Sensors Test

Ef. . [% i Type of Yalves

section 50

£

Define and Mo d.iﬁf ‘alve Data

BEIES

I3

This opens the following dialog:

Y

F ( L]
i &

Id | Name Address V.Type Dec.Type | Pipe Section | Description
1 101 352595 13 4 1 TLEF
2 102 3247 13 4 1 TURF
3 103 352595 13 4 1 TLEF
4 104 35299 13 4 1 TURF
5 2 35264 13 4 1 TLEF
3] 202 35285 13 4 1 TURF
7 203 35266 13 4 1 TLEF
5] 204 30287 1 4 1 MOT USED
2] 3 35300 3 4 1 =HRLIE
1o 302 35301 3 4 1 TREE
1M 303 35302 13 4 1 TLEF

:

Now you must fill in all the columns of the grid, describing a decoder on each line:

ID
This is auto generated when ever you add another decoder, so don't touch this.
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Pumps

3.

Name
An arbitrary name you provide for the decoder - max. eight characters.

Address
The unigue address for this decoder - valid range is 0-65535. The PROCOM will send commands
to this address to control this decoder.

V. Type
Type of valve connected to this decoder. Valves are identified by ID number, so the values in this
column are mapped against the ID column of the valve types.

Dec. Type
The type of this decoder. This is used to calculate the power consumption. Here's a list of decoder
types and the values you should type in for each:

For this decoder type... ...type in this number
LD-050/LD-100 1
LD-200 2
LD-400 4
LD-600 6

g Note
When running the Line Survey test, the PROCOM will assume that all decoders are
"full", meaning that the calculations for an LD-600 will assume that six valves are
connected. If that is not the case. Please refer to Section 5.1.4, “Line Survey” [page 119]
for the full details.

Pipe Section
Which (hydraulic) pipe section is this decoder attached to?

Description
Your own free text description of up to 200 characters.

Click the exit button to save your decoders and close the dialog.

3.4. Pumps

3.4.1. Pump Decoders

Though you could use a regular decoder to control pumps as well, typically you will use a dedicated "pump
decoder". A pump decoder is typically not encapsulated for field placement like regular decoders, and is
equipped with a relay.

To maintain your pump decoders, follow this procedure:

1.

Open the Pumps menu and select Pump Decoder:
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Pump Decoders

E_i ProCom, - Installation

Setup  Pipes  Walves [EEsEM Sensors  Tesk
| fgn
Section 5{0.07) ot
b
3 ! L
Define and Modify Pump Data

This opens the following dialog:

Hpump Decoder

EJ

| Pump | Address Status | Capacitﬂ Priority |0N delay| OFF delay| Electric Description |;
1 284 Installed 35 1 ] 10 AFFAZ0 | Left main pump
[B 2686 Mot [nstalled 0 1] a 10 4FFAZD |- [
[ Total:. D Not Installed 0 0 0 10 AFFAZ0 | '

-

Now you can add or modify the pump decoders in your system - here's a description of the fields:

Pump
The ID number of the pump - this is assigned automatically and you can not change it manually.

Address
The decoder address. This is automatically filled in but can be changed manually. The type of pump

decoder normally used with a PROCOM system have 10 predefined addresses which start at 284,
skip 285 and then continue for nine more slots - the suggested values will adhere to this scheme.

Status
Choose between Installed and Not Installed. If you choose Not installed, the pump is known to the

system but can not be managed by users with only user level access. See Section 1.3.1.2, “Different
Password Levels” [page 3] for details on the different access levels.
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Sensors

3.

Capacity
The capacity of the pump this decoder is running. The unit is what you have chosen in Section 3.1.1,
“Parameters” [page 18].

Priority
Select between the following values:

Setting Description

0 Select zero when the pump is not installed / not
available.

1-6 Choosing a number in this range sets the priority

of the pump decoder. Pumps run by decoders
with priority 1 are started first, then priority 2
decoders etc. Once the needed capacity is met,
no more decoders are activated.

If two or more pumps have identical priorities, the
PROCOM will try to burden them equally by
alternating between them. This will make sure
that one pump doesn't get worn down by always
being run while the other pumps are idling.

S Select "S" for slave pump.

On delay
Number of seconds the pump should stand by before activating when a valve is opened on its pipe.

Off delay
Number of seconds the pump should delay its termination after the last valve on its pipe has closed.
This is useful to ensure that a pump doesn't shut down only to start again when a new valve opens
just a few seconds later.

Electric
Switch codes - please see Appendix B, Switch Codes [page 139].

Description
Free text description of up to 200 characters.

Once you're done, click the exit button to save your pump decoders and close the dialog.

3.5. Sensors

3.5.1. Sensor Inputs

The PROCOM will accept input from a number of sources. The following procedure shows you how to
configure the controller to interpret these inputs.

1.

Open the Sensors menu and select Sensor inputs:
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Sensor Inputs

B(=1ES

E_i ProCom, - Installation

Setup  Pipes  Walves Pumps BEEgsnles Test
o [
H B Edit Sensor Decn!g l
Section 5{0.07) £5
b
L ! 2.
Define and Modify Sensor Input (built-in)

This opens the following dialog:

: - )B)X]

s

Name Status | Type
** Rain Check ™ |Installed [ WD
* Alarm Sensor ® .Installed .NID
*Line Yaoltage *  Installed NIT
* Short Circuit®  Installed s
*YWS Wind Speed®  Installed /O
* WS Rain Limit*  Installed s
WS Temperatur® Installed /O

Now you can configure the different input sensors:

Name
Sensor Description
Rain Check This sensor receives any input on the input
terminal labeled "Rain Sensor".
Alarm Sensor This sensor receives any input on the input

terminal labeled "General Alarm". Typically this
is where you feed the controller any alarms from
pumps.
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Edit Sensor Decoder

Sensor Description

Line Voltage Built-in alarm for leaks on the two-wire path.

Short Circuit Built-in alarm for shorts on the two-wire path.

WS Wind Speed Weather Station alarm for high winds exceeding
the configured maximum.

WS Rain Limit Weather Station alarm for rain level exceeding
the configured maximum.

WS Temperature Weather Station alarm for temperature dropping
below the configured minimum.

3 Note
The Weather Station (WS) Sensors are only listed if your controller is licensed to run
a weather station. Check out Section 4.13.4, “Weather Station Setup” [page 106] for
details on how to configure the limits mentioned above.

Status
Choose between Installed and Not Installed.

Type
Choose between Normally Open (N/O) and Normally Closed (N/C).

3. Once you're done, click the exit button to save your pump settings and close the dialog.

3.5.2. Edit Sensor Decoder

1. Open the Sensors menu and select Edit sensor decoder:

ﬂ ProCom, - Installation

Setup  Pipes Malves Pumps BEEREREN Test
Iy Sensor inpuks

y B Edit Sensor Decoder

N
=ection 1(500.0)
Main PipeS00.0)
Section 2(500.0)

L

< >

Define and modify Sensor Decoder

This opens the following dialog:
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Edit Sensor Decoder

E_i Edit Sensor Decoder.

| Name | Type Address Units Flow | o] | il
F=1 Flow Sensor  S0371 Fulsef0s 4400 228

I Flow Sensor |0 Mot installed |0 0

I Flow Sensor 0O Mot installed |0 1] -1

Now edit the settings for each decoder:

Name

Your own name for the sensor decoder. No more than six characters - don't use "special characters"
here.

Type
The type is fixed - all sensors in a PROCOM system are flow sensors.

Address
Value between 0 and 65535

Units
Select between Pulse/10s and mA.

Flow
The flow in the units selected in Section 3.1.1, “Parameters” [page 18].

@
The physical reading of either number of pulses per 10 seconds or mA, depending on what you
choose above.

Once you're done, click the exit button to save your settings and close the dialog.
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Chapter 4. User Data - Day to Day Usage

4.1. Selecting a site

To select a site to work on, follow this procedure:

1. Open the System menu and select Select site:

(=[5

M - User Passwd | Inst. Passwd I

No Active Site]]
| Marual Setup Miew  Help

Phone baook,
Seleck COM Port

Loimioad LU Soriware

Exxit

TUCOR INC.
DEMO

518 WALLACE ROAD
WEKFORD

51090

P,

N
PROCOM -

Select site | Off Line

Now you'll see a list of available sites:
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Selecting a site

2.

hnnse Site - [- [No Active Site]] '

Permanent Staff - East Bay
zummer Replacemerts - East Bay

Select the site you wish to configure and click OK. Now you'll see more active menus in the main
window:

Systemn  Irrigation  Manual  Setup View  Help

EI@ E - Uszer Pasgswd | Inst. Passwd I

TUCOR: INC.
DEMO

518 WALLACE ROAD
WEXFORD

51090

PA,

PROCOM:so

Pressing this button will close the window | Off Line
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Maintaining Accounts and Sites

@ Note
You can select and configure sites that don't have a valid controller license key. Only when
you need to transfer the configuration will you need a valid license key for the controller.

4.2. Maintaining Accounts and Sites

Accounts, sites and licenses are maintained in the "Phone Book". To access the Phone Book:

1. Open the System menu and select Phone book:

fi ProCom - [Permanent Staff - West]

SEE Irrigation Manual  Setup View  Help

Select site tﬂﬁ.l - User Pasawd | Inst. Passwd |
Select COM Part g

Download CU Software

Exxit

TUCOR INC.
DEMO

518 WALLACE ROAD
WEXFORD

51090

PA

PROCOM 05

Edit phone book Off Line

This brings up the Phone Book:
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Maintaining Accounts and Sites

[ 0 : N0 | |
B
Id | Account Site Phone (Mo of valves License -
1 FPermanent Staff West Com2 500 Ok
]

Now you can edit the fields for each account in the Phone Book:

2 Important
You must enter the account name as the first thing when creating a new account. Only
when the account name is entered is the database ready to receive the remaining data.

Id
This is automatically filled in when you enter a new account name.

Account
This is your name of choice to identify an account.

Site
Your own name for the site.

Phone
This is the number the software will need to connect to the PROCOM. It can be a phone number
when using a modem, or a COM port when connecting directly to the controller. Clicking in this field
will bring up an assisting dialog:
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Maintaining Accounts and Sites

Select COM Port for direct connenction, or Modetn for remote connection.

=elect Service ComPort
COM - Communications Port (Standard port types)

COME - Kevspan USH Serial Port (Keyspan)

COME - CP2101 USE to UART Bridge Controller (Silicon Laboratories)
COMI - PCI Communications Port (Enhanced portz)

COM3I - USB-o-Serial Port Driver (MosChip Semiconductor Technology)
COMA O - Yirual IR COM Port (Jan Kiszka)

COM11 - USB-o-Serial Port Driver (MosChip Semiconductor Technology)
COh 2 - ATEM IISE to Serial Bridge (ATERN)

Modem - Enter Phone # below

)

i DR R B B B B

When choozing Modem, enter the phone number of the controller.

If you're connecting directly to the controller, select one of the available COM ports. If you're using
a modem, select Modem and enter the phone number below.

@ Tip
If you're behind a switchboard or need to wait for a dial tone, you can use commas to
make the modem wait for a little while before dialing (i.e. "9,,,,61789034").

No of valves
This is set automatically based on the license you have acquired for the controller.

License
Clicking in this column will bring up a dialog for you to enter the license information in.

See the details on how to enter the license key in Section 2.1.3, “Entering Controller License
Keys” [page 11].
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Setting the User Level Password

4.3. Setting the User Level Password

You can protect the user level settings by changing the blank default password to something else. (Read

more about passwords in Section 1.3.1.2, “Different Password Levels” [page 3]).

1.

3.

If you want to set the user level password for a specific site, connect to the site as explained in

Section 4.1, “Selecting a site” [page 39] - otherwise ignore this step.

Open the Setup menu and select Password:

R ProCom - [001 - SIENNA]

Systemn  Irrigation  Manual BEEEEN Yiew  Help

Date and Time

Weather Skakion [ !

PROCOM 500

Add ar Change User Password

E@ Installation Data E - e — | _

TUCOR INC.
DEMO
WisLLACE ROAD
WEXFORD
51090

PA

Off Line

Now the dialog for changing the password pops up:
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Communicating with Controllers

User Password Definition [Site lo...

Type current Password |
Type Mewy Passward
Type Mewy Passward &GAIN

If this is the first time you change the password, leave the Type current Password field empty.

4.4. Communicating with Controllers

The PROCOM software will communicate with controllers in the field in order to do two things:
» Transfer configurations, irrigation schedules etc. from your PC to the controller.

» Transfer monitor data from the controller to the PC - this data can then be analyzed with the log viewer
or your own tools.

To enable the controller and the PROCOM software to communicate, you must connect your PC to the
controller via either a modem or a direct connection - Section 4.2, “Maintaining Accounts and Sites” [page 41]
has the details on how to configure the communication.

Once configured, here's how you connect the software to a controller (If you're having problems connecting,
check out Section A.1, “Troubleshooting the connection” [page 137]):

1. Signinto a site as described in Section 4.1, “Selecting a site” [page 39].

2. Click the Offline button in the main window to try to connect and change the state to Online:
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Communicating with Controllers

f& ProCom - [West]

System  Irrigation Manual Setup View  Help

ger Pasawd | Inst. Pasawd |

<

TUCOR: INC.
DEMO

518 WALLACE ROAD
WERFORD

51090

P,

PROCOM 505"

Communication status Off Line

This will bring up the Communication Status window:

i Communication Status rg|

& D e

Monitor Data Selection
f* Do MOT Retrieve Data (" Retrieve Data

LB

Statuz
Ready to perform connection to the controller
Meszages
~
w
3] >
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Communicating with Controllers

3. To connect to the current site's controller, click the Connect button:

ﬂ Communication 5t=1._

Monitor Data Sele
f* Do MOT Retrieve Data [ Retrieve Data

LB

Status
Ready to perform connection to the controller
Messages
-
-
£ >

@ e
When you select "Retrieve Data" all monitor data in the controller will be transferred to the
PC and deleted in the controller. Though this is a good thing since the controller does not
have unlimited memory, keep in mind that it might not be what you want to do if you're just
connecting to check ET data or something minor.

Now the Status field will say "Connecting to controller" and you will have to wait a little while for the
connection to be established. If you can't seem to get a connection, check out Section A.1,
“Troubleshooting the connection” [page 137].

4. Once the connection is established the Disconnect button will pop out and the Connect button is now
pressed instead. You will also see that the Offline button in the main window changes to green and
says On-line:
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Communicating with Controllers

5.

f& ProCom - [Permanent Staff - West]

System  Irrigation Manual Setup View  Help

Eg M _ Uszer Pazawd | Inat. Pasgewd |

TUCOR: INC.
DEMO

518 WALLACE ROAD
WERFORD

51090

P,

PROCOM 505"

Irrigation Off

Now the software tries to find out whether the settings on the controller matches those on the PC. If
you have made configuration changes in the software, you'll see the Messages field say "Need to
Download All Data to CU"

To synchronize the configuration in the controller, click the Download button:
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ﬂ Communication Status

Status
Connected, but idle - ready far hang up
Messages
Meed to Download All Data to CU A
-
£ »

3 Note
"CU" is short for "Central Unit" - the controller.

You can follow the process in the Messages field.

6. Once you're done synchronizing, click the Disconnect button to disconnect and the Exit button to close
the dialog.

4.5. Irrigation Schedules

Based on the hardware defined in the installation data, you design irrigation schedules to perform the actual
irrigation. These schedules are highly configurable and really lets you fine tune how the system resources
are used.

The following sections describe how you create, maintain, test and optimize irrigation schedules.

4.5.1. Managing Irrigation Schedules

Follow this procedure to add new irrigation schedules or view/modify existing ones:

@ Note
When ever you have added or modified an irrigation schedule it's a good idea to perform a dry
run as explained in Section 4.5.4, “Dry Run All Schedules” [page 60] to ensure that no overlaps
or resource shortnesses will interfere with your irrigation.

1. Open the Irrigation menu and select Irrigation Schedules:
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f& ProCom - [West]

Systemn BIGEEEREN Manual Setup View  Help

Eg E - Uszer Pazawd | Inat. Pasgewd |

Seckars
Purp Skatus

Sensor Wizard
Sensor Skakus

TUCOR: INC.
DEMO

518 WALLACE ROAD
WERFORD

51090

P,

PROCOM:soo

Edit Irrigation schedules Off Line

Now you'll see the list of irrigation schedules:

ki Irrigation Schedules

B &
Id| Status | Name Week Days |Star|:s| Method |Budget (%]| Time/mm | Dec’s |5im.Time Description I;
1 |Passive Autotest | --——---- ———--—- 1 Autotest 100 Time 126 00:.02
2 Passive NEWSOD |[MTWTFSS MTWTFSS 3 Autornatic | 100 Tirme 1 omo2 2 WEEK GROW-IN  —
3 Active | LAWMN HTUTF35 MTWTFSS |4 Automatic 100 Time 1 0242 LAWYN SCHEDULE
[ 4 Actve |SHRUES | -—————- R 31 Autormatic | 100 Time 1 01:32 | DRIP SHRUES
[ 5 Actve |TREES  |—————- L 31 Autornatic | 100 Tirne 1 002 | DRIP TREES
[ 6 Actve |PALMS  |—————- R 1 Autormatic | 100 Time 1 0202 | BUBBLERS - PALMS
[ 7 Passive |FLOWTEST ————- G- ——— 1 Sequential | 100 Tirne 126 10:32 | Flow Management
:8 Passive |BAZING ————--= ———-—— 1 Automatic 100 Time 1 ooze - ﬂ

@ Note
The Autotest schedule is a built-in schedule for which you can only edit included decoders
and weekly activation days. The Autotest will test all included decoders in turn, like the test
described in Section 5.2.1, “LD Response” [page 123]. You must set the run time for each
decoder to "1" - this won't be treated as one minute, but just indicates that the decoder
must be run.
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In the dialog you can add new schedules or edit the existing ones. To edit existing schedules, simply
click in the fields you wish to change. To add a new schedule, click in the Name field and type in the
name for your new schedule.

Here's a description of the fields in the dialog:

Id
ID of the schedule - this is assigned automatically and you can not change this. Though the PROCOM
support up to 30 schedules only, the numbers will keep incrementing if you delete schedules and
add new ones - that way you can still identify old entries in your logs even if the schedules no longer
exist.
Status
Select between Passive and Active. Note that passive schedules can still be run manually.
Name
Your own short name for the schedule.
S Note
The name can be no more than eight characters long. If you try to type in a longer
name you'll be blocked and hear an alert beep.
Week Days

This field describes which week days in a two week cycle the schedule will run. When you click in
this field, you'll see the following dialog:

| Ok | |ﬁpp1].r | |xlian|:el|
[ Monday I Monday
[ Tuesday [ Tuesday
[ wednesday [ Wednesday
[ Thursday [ Thursday
[ Friday [ Friday
[ Saturday [ Saturday
[ Sunday [ Sunday

Check the days you want the schedule to run and click OK to save your selection.

E I Note

When your schedules are running you can always check which day of the cycle you
are at by bringing up the Status dialog and looking at the number between the date
and the time:
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Irrigation status

On Line (Weather st.) Thu Apr 3

Irrigation Contral
2 ] @ | | @ |whene

Active schedule

schedule Remaining Remark

Time YWindow

Irrigation will be closed from: oo:n0 to: | 00:00
Manitar

In this example we're at day four, which means that it is Thursday in the first week of
the cycle.

Starts
This field describes the times during the selected days that your schedule will run. When you click
in this field, you'll see the following dialog:

g | Start Times -~

0g:aa

12:00

16:00

20:00
li

1
2
3
4
g
G
7
a
9
1
1

— O
1 1
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Add the start times and click the Exit button to save your entries and close the dialog.

@ Note

All times are assigned in military time. If you're unfamiliar with military time notation,
check out Appendix C, AM/PM to Military time conversion [page 141].

Method

This field describes how the decoders in the schedule will be run. You can choose between the
following values:

Sequential
One decoder at a time, in the order they are assigned to the schedule.

Priority
Let the flow management decide when the decoders run, but run them in the assigned order.

Automatic
Let the flow management take complete control of how the schedule is run. The approach here
is to open the biggest valves first, and then "fill up the pipe" with smaller and smaller valves
until the maximum pipe capacity is reached. If you want finer grained control over the order in
which valves get run, you should use the Priority method.

Budget (%)
This field describes the water budget for the schedule. The budget is provided in percentage and
you can set the value to anything between 0 and 300.

What this means is that the schedule will be run either shorter or longer than it was originally
configured to.

A Caution

If you increase the budget to an extent where a schedule will overlap another schedule,
the next schedule will simply not be run. To check for overlapping schedules, do a "Dry
Run All" as described in Section 4.5.4, “Dry Run All Schedules” [page 60].

Time/mm
This field lets you select what will control the length of each run of the schedule:

g Note

The unit used here depends on how you initially configured the system in Section 3.1.1,
“Parameters” [page 18]

Time
The schedule will run for exactly as long as it is configured to.
ET Correct

The schedule will accept corrections from the ET input. This could mean shorter run times if
there has been a lot of rain and longer run times in extraordinary dry periods.

Amount
The schedule will run until it has irrigated a certain amount of water.
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3 Note
If you select ET Correct or Amount, the run time is calculated based on the application
rate of the valve types used. Read more about application rates in Section 3.3.1, “Types
of Valves” [page 29].

Dec's
This field describes which decoders or sectors are included in the schedule and how they are run.
When you click in this field, you'll see the following dialog:

i L]

i

Type Name | Min | mim | ET | il
Decoder 1001 5 Q.00
Decoder 1002 5 Q.00
Decoder 101 5 Q.00
Decoder 102 5 Q.00
Decoder 103 5 Q.00
Decoder 104 5 Q.00
Decoder 1101 5 Q.00
Decoder 1102 5 Q.00
Decoder 1201 5 Q.00
Decoder 1202 5 Q.00
Decoder | 13071 ] 0.00
Decoder 1303 5 Q.00
Decoder | 1302 ] 0.00 vI

To edit the elements, click in the fields you wish to change. Here's a description of the fields in the
dialog:

Type
The type can only be selected when you assign a new element to a schedule. You choose
between Decoder and Sector and this then determines what can be selected in the Name field
above.

Name
The name that identifies the decoder/sector - this is a list of decoders/sectors known to the
system.

Check out Section 3.3.2, “Line Decoder” [page 30] and Section 4.6, “Sectors” [page 67] for
descriptions of how decoders and sectors are managed in the system, respectively.

Min
This is the run time in minutes.
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Inch/mm
This is a calculated field that tells you how much water will actually be used. The number is

calculated from the run time entered above and the application rate for valve types for the
decoder(s) used (see Section 3.3.1, “Types of Valves” [page 29]).

@ Note
The unit used here depends on how you initially configured the system in
Section 3.1.1, “Parameters” [page 18]

ET
This is the adjustment in relation to ET. Set to "1" there will be no correction.

2 Important
When the PROCOM calculates how to run an irrigation schedule, it creates a list of all
decoders included in the schedule, directly assigned or part of an included sector. If a
decoder is assigned directly and also included in an included sector, the configuration
for the directly assigned one will be used and the decoder ignored when running the

sector.

Sim.Time

The time a simulation run will take. A star (*) indicates that the schedule configuration has changed

since the last simulation run.

For details on simulating a run, please refer to Section 4.5.3, “Performing a Dry Run” [page 58].

Description
Free text area for your own description of this schedule.

3.  When you are all done configuring the irrigation schedules, click the Exit button to save your settings

and exit the dialog.

In addition to editing the main fields in this dialog, you can right click in the Id column to get a few more
options:
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bl Ir rigation Schedules

¥ &

||l:|| Status | Name Week Days |Starts| Method |Budget [%'_I| Time/mm | Decs

3 Active | LAWY MTWTF23 MTWTF23 |4 Autormatic | 100 Tirme 1

B Active PALMS | -————- 5 ————— 301 Automatic | 100 Time 1

4 Active |SHEUB: | -————- R 301 Autormatic | 100 Tirme 1

5 Active TREEZ — |—-=———- 5 ————— 301 Automatic | 100 Time 1

T llomoine o 1 Autotest 100 Tirme 126

[ ——( = SR 1 Automatic | 100 Time 1

z  Print Preview ITUTFSS MTWTFSS |3 Automatic | 100 Time 1
Prink .

IR S 0| Ssquenia ET Carcis 0

g— - - 0 Sequential | 100 Time o -

- ser's | LIJ
Installer's

The Print Preview, Print and Dry Run, all Schedules should be self explanatory, and the two bottom options
- User's and Installer's let you set the respective passwords.

4.5.2. Deleting an Irrigation Schedule

To delete an irrigation schedule:

1. Open the Irrigation menu and select Irrigation schedules:
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2.

=

E_i ProCom - [West] |Z

Seckars
Purp Skatus

Sensor Wizard
Sensor Skakus

TUCOR: INC.

DEMO

518 WALLACE ROAD
WERFORD

51090

P,

PROCOM 505"

Edit Irrigation schedules Off Line

In the dialog that opens, left-click in the grey area next to the schedule you wish to delete:

ﬁ Irrigation Schedules

Fe| 5

|Id| 5tatus| Name Week Days |5tarts| Method |Budget |:".-'E|:|| Time!mm| Dec's [+
5 |Active |TREEE  |-—————- 8 ———— 31 Automatic 100 Time 1

1 PFasswe Autotest | -——---- ——---—- 1 Autotest 100 Tirme 126

8 |Passive BASINE | -——---— ——————- 1 Automatic | 100 Time 1

7 |Passive FLOWTEST ----- S ———— 1 Sequential | 100 Time
N qssive | NEWSOD | MTUTFSS MTUTFSS 3 Automatic | 100 Time 1

‘ X Qassive | 0 —————m - 0 Sequential 100 Time 0

o
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3. Push the Delete button on your keyboard and confirm the deletion to remove the schedule:

2K to delete this enkry 7

4.5.3. Performing a Dry Run

When you have configured an irrigation schedule it's a good idea to perform a "dry run". Adry run is a
simulation of an irrigation that will tell you a lot of things about the schedule:

» Do the pipes have enough capacity to run the decoders in your schedule in the order and duration you
want?

» Will any pump settings interfere with your schedule?

» How is the pipe capacity used when running your schedule? (More on this in Section 4.5.5, “Checking
Pipe Utilization” [page 61].)

All'in all, doing a dry run before you deploy a new schedule is a good idea - in fact, the dry run is a useful
tool for designing your schedules in the most economical way.

Here's how you perform a dry run on one of your irrigation schedules:

1. Open the list of irrigation schedules as described in Section 4.5.1, “Managing Irrigation
Schedules” [page 49].

2. Click in the Sim. Time column of the schedule you wish to test:

E-i Irrigation Schedules

| b

Week Days | 5tarts| Method | Budget [".-'h:l| Time/mm | Dec's | 5im.Time|
MT--F3- MT--F3- 2 Automatic 100 Tirre 3 Q007
M-U-F33 M-U-F33 1 Automatic 100 Tirne 18 o022
MT--F3- MT--F3- 2 Automatic 100 Tirre 5 Q007
M-U-F33 M-U-F33 1 Automatic 100 Tirne 27 ao.32
M- 3 M- S 1 Automatic 100 Time 4B
M-U-F33 M-U-F33 1 Automatic 100 Time 7
M--T--3 M--T--3 1 Automatic 100 Time 30
-T-TF3- -T-TF3- 1 Automatic B0 Time 2
MTWTFSS MTUWTFSS 2 Automatic 100 Time 18
MTWTFS3 MTWTFSS 1 Automatic 100 Time 22

F
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Now the dry run is performed and you'll see a list of results that looks something like this:

B ProCom for, Windows

Dry Run of Schedule: LOT F

Day Time  ‘alve Action Flowy (Fpam)

1) O:00 LOT F START 4
{ 1y 0:01 108k STARTED 35

1) 0:01 108& STARTED 7z

1) 0:01 1087 STARTED i0s

1) 0:01 103 STARTELD 144

{ 1y 0:01 1108 STARTED 142

1) 0:01 1105 STARTED 152

1) 0O:04 108E STOPPED 11&

1) 0O:04 108& STOPPELD a0

{ 1y 0:04 10827 STOPPED 44

1) O:04 1085 STOPPED 2

1) O:04 1050 STARTED d4d

1) 0O:04 1091 STARTELD a0

{ 1y 0:04 1092 STARTED 115

1) O:04 1093 STARTED 152

1) a:0o7 1050 STOPPED 11&

1) o:07 1091 STOPPELD a0

{ 1y 0:07 109z STOPPED 44

1) O:07 1094 STARTED 20 3
’ 14 m-nn" 1inarc CTATITTET 11 & —

Chart
) (&) (]
| I LYY

This window tells you everything you need to know about each step in the schedule. If you've made
mistakes like the ones listed earlier (exceeded pipe capacity, overlapped start/stop times etc.) it will be
listed in this window and you can go back and re-configure the schedule.

Here's what the buttons in the lower part of the window mean:

Chart

Clicking this will bring up a chart explaining the pipe
utilization. Check out Section 4.5.5, “Checking Pipe
Utilization” [page 61] for more detail on this.

1

Clicking this will print the report.

1[4

Clicking this will just close the window.
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4.5.4. Dry Run All Schedules

The "dry run all" is probably one of the features you'll be using the most in your daily work with irrigation
schedules. It works exactly the same way as a regular dry run, only it includes all schedules which is extremely
useful for making sure that you don't have overlaps or resource shortnesses in your system. Since the
PROCOM will only run one schedule at a time, optimizing is an important part of the schedule design job
and the "dry run all" is the main tool.

To perform a dry run of all schedules:

1. Open the list of irrigation schedules as described in Section 4.5.1, “Managing Irrigation
Schedules” [page 49].
2. Click the dry run all button:
i (1 [l L]
B (5
" Status Name Week Days | Startsl Method | Budget (%) | Tin*
g5 Active 1TUSPAR MTW-F33 MTW-F33 1 Autormatic 100 Tim
1 Active Autatest —TUTF3S -TUTF3S 1 Autotest 100 Tirn
a4 Active B1 SHRL| M-W-F33 M-W-F33 1 Autormatic 100 Tim
a5 Active B1 TURF |MT--F2- MT--FS- 2 Automatic 100 Tirn
) Active BZ SHRL | M-W-F33 M-W-F33 1 Autormatic 100 Tim
a7 Active B2TURF |M---F3- M-—-F3- 2 Automatic 100 Tim
a8 Active B3 SHRL | M-W-F33 M-W-F33 1 Autormatic 100 Tim
a9 Active B3 TURF | MT--F3- MT--F3- 2 Automatic 100 Tim
B0 Active B4 SHRL | M-W-F33 M-W-F33 1 Autormatic 100 Tim
?1 Active B4 TURF | MT--F5- HT——ITS— 2 Altomatic 100 Tim ~
1 3
3. Now you'll get a report that will point out any conflicts - here's an example that includes overlapping
start times:
60 173-230-0001/B



Checking Pipe Utilization

B ProCom for, Windows

Dry Run of all Schedules

Day  Time Scheduls Action Status

[ 7)1 4:32 SHRUES FINIZH

{71 1l0:30 LAWM START

[ 71 l4:32 LAWH FINIZH

{7y 17:30 LAWH START

[ 71 Z1:00 TREES START Beject (Start time owverlap)
[ 7y Zl:3z LAWN FINIZH

[ 7y £3:0FZ TREE: FINISH Beject (Start time overlap)
{ &) 10:30 LAWH START

[ 8) 1l4:32 LAWN FINIZH

[ 8) 17:30 LAWN START

| B) E£1:3Z LAWN FINISH

{ 9) 10:30 LAWH START

[ 9) l4:32 LAWN FINIZH

[ 2) 17:30 LAWN START

| 9} E1:3E LAWN FINISH

(10) 10:30 LAWH START

(10} 1l4:32 LAWN FINIZH

(10} 17:30 LAWM START

110}y £1:3E LAWHN FINISH

11N 1n-2M0 T ATTAT CTATIT

Chart
L2 | (& [ ]

The buttons are pretty self-explanatory but you'll find descriptions in Section 4.5.3, “Performing a Dry

Run” [page 58].

2 Important

When you do a dry run to check for overlaps in your schedules, you should consider that in real
life your ET device might alter the run time for your schedules, creating conflicts that don't show
when you perform the dry run. This happens because the dry run uses the default ET settings,
so if you want to be absolutely sure that not even ET corrected schedules can conflict, you
should set the default ET to the maximum before performing the dry run.

Check out Section 4.13.2, “ET default value” [page 103] for instructions on how to change the

ET default.

4.5.5. Checking Pipe Utilization

One of the challenges of creating a good irrigation setup is to utilize the pipe usage to its fullest. In the ideal
setup, water flow in the pipes is constant while all parts of your turf are being watered sufficiently.

The PROCOM will show you exactly how the network of pipes is being utilized for each irrigation schedule
in your system and even show it to you in a graphical manner. To check out the pipe utilization, follow this

procedure:
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1.

2.

Select the irrigation schedule you wish to check and perform a dry run of it as described in Section 4.5.3,
“Performing a Dry Run” [page 58].

In the dialog of the dry run, click the Chart button:

I ProCom for Windows

Dry Run of Schedule: LOT F
Day Time  ‘Valve Action Flowy [(am)
{ 1y 0:00 LOT F START N
1) 0:01 108& STARTED jE1
1) 0:01 108& STARTED TE
1) o:01 1087 STARTED los
1) 0:01 1ogs STARTED 144
1) 0:01 1108 STARTED 1l4s
1) 0:01 1105 STARTED 1E5E
1) 0:04 1085 STOPPED 116
1) O:04 108& STOPPELD 20
1) O:04 1087 STOPPED 44
1) O:04 10859 STOPPED g
1) O:04 10920 STARTED o4
1) O:04 1091 STARTED 20
1) O:04 1092 STARTED 116
1) O:04 1093 STARTED 1E5E
1) o:a7 10920 STOPPED 116
1) a:07 1091 STOPPELD 20
1) a:07 109z STOPPED 44
1) O:07 1094 STARTED 20 3
’ 18 m-n" 1narc & T TTT: 11 & p—
E1RE

Now a graphical representation of the dry run will appear:
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B ProCom Dry Run Chart

Foom  Print  Show

TLOT F " Water Flow: "5644" (Zal's) Time: T0:557

B ]

1140

o
w izl

100

80 -

B0
40

20

I:I | | | | |
oo: o0 ao: 10 oo: 20 oo:=0 ao: 40 oo: 50

T ime

Tirne '0:55" with flow 0.00°

The example here has poor pipe utilization in the last third of the schedule or so. For more information
on how to read the utilization chart, check out the following section.

4.5.5.1. Understanding the Pipe Utilization Chart

The Pipe Utilization Chart tells you how much water is flowing in the pipes during the run of an irrigation
schedule. In a perfect system the flow is constant throughout the irrigation, and during a poorly planned
irrigation, the flow changes all the time - the utilization chart gives you a quick graphical understanding of
how your schedule is placed in this range.

First, here's how a perfectly planned irrigation looks on a utilization chart:
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B ProCom Dry Run Chart

Foom  Print  Show
F TPAIMET Water Flow: T216" (Zal’'s) Time: "0:29°7
1
o T
W oGt
5 -
4 -
3 -
2 -
l -
|:| 1 1 1 1 1
oo: 00 O0: 05 oo: 10 oo:15 oo:20 O0: 25
Time

In comparison, here's an irrigation that is less fortunate for pipe utilization:

B ProCom Dry Run Chart E@E|

Zoom  Print  Show

TLOT F " Water Flow: "5844" (Zal'=s) Time: "0:55"T

B ]

1140

120
100 -
80 -
a0 -
40

20 F

|:| | | | | |
oo: 00 oo: 10 ao:zZ0 oo: 30 oo: 40 ao: 50

T ime

Tirne ' 0:95" with flow 0.00°
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Most of your irrigation schedules will probably be something in between. The chart below shows an irrigation
that isn't perfect, but very realistic. Note how placing the cursor on the graph will tell you exactly what the
flow is at that point in the schedule (shown in the lower status bar):

B ProCom Dry Run Chart

Zoom  Print  Show
F '™ TURF' Water Flow: T24528' (Gal's) Time: "2:55°7
1
014EI -
w120k

100

g0 f

a0 F

40 f

20 F

I:I | | | | | | | |
oo0:00 00:20 00:40 01:00 01:20 01-40 0Z:00 0Z:20 0Z: 40
T ime

Tirme " 2:33" with flow 125.11°

@ Tip
If you want more detail about a certain part of a longer schedule, you can drag and draw a

rectangle on the chart, and you will zoom on the selected area:
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B ProCom Dry Run Chart

Zoom  Prink

F

a

1

014EI -

wilz0 f
100 f
80 f
a0 F
40 f
20 F

Shioy

'C TUERE'

Water Flow:

TZ24528T

8=

(Gal’

TZ2:557

Tirme ' 2:55" with flow 121.60°

O0:00 0O0:=20 00:40 01:00 01:Z2Z0 01:40 0Z2:00 0Z:=20 0Z:40

T ime

Next you'll see the rectangle enlarged:

B ProCom Dry Run Chart

Zoom  Prink

F

Shaw

'C TUERE'

Water Flow:

T24528"T

W 150 +
145 |
140 -
135
130

125

1155—

U

(Zal™=)

EEX

Time: 'TZ:55"T

0=:00

0=:10

Tirme ' 2:48" with flow 155 22"

0=:=z0

0=:30

0z: 4
T ime

To return to the view of the whole chart, select View all from the Zoom menu.
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4.6. Sectors

Sectors is a way of grouping a number of decoders logically, regardless of how they are connected to the
grid of pipes in the ground. For example, if you're responsible for a large irrigation system, you might want
to group a number of decoders that water certain areas: "north lawn", "front shrubs" etc. in order to control
all decoders in different areas in a uniform way.

The advantage of using sectors is that you can use them directly in your irrigation schedules, and the
PROCOM will take care of activating the right decoders when the sector is up for irrigation. See Section 4.5.1,
“Managing Irrigation Schedules” [page 49] for more information on how to do this.

Since sectors are really just a group of decoders, the only information you need to provide to create a sector
is the list of decoders included, and a name for the sector.

Here's how you create and edit sectors:

1. Open the Irrigation menu and select Sectors > Display/Modify Sectors:

fe& ProCom - TRAINING - [PACIFIC SHORES A - Controller A]

Swystem QIGEEG® Manual Setup Yiew  Help

E@ Irrigation Schedules | N\rJ User Pagswd | Inst. Passwd |

Seckars Display | Maodify

Pump Status Display all Decoders k

Sensor \Wizard
Sensor Skakus

TUCOR INC.
DEMO

518 WALLACE ROAD
WEXFORD

51090

PA

PROCOM 305

Display and Edit Sectors and their contents Off Line

This will bring up the following dialog:
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Bl Sector Edit - All M =3
| Id | Name Capacity | Decoders Description *
1 SEC123 177.00 8| Used for drive.

2 SECZ 0.00 al-
3 SEC3 0.00 al-
Tatal 177.00 al-

-
1| | 3

2. Now you can fill in or edit the fields for each sector:

Id
This field can not be edited - it's automatically assigned by the PROCOM.

Name
Your name for the sector - up to six characters.

Capacity
The capacity of the sector. This is automatically calculated based on the decoders you include in
the sector.

Decoders
This field shows the number of decoders included in the sector. You edit the list by clicking in the
field, which will bring up the following dialog:

Jecoder Inspla BEE
it

Vid Name Capacity | Parent -
2 DREBED 2400 SEC123
14 COBLBED 2000 SEC1Z3
] DRGR 10,00 SEC123
1 DEEEDBALZ B.00 SEC1Z3
35 BOBGATE 2700 SEC1Z3
33 BDARBRENM 3500 SEC1Z3
13 CLURBGR 23.00 SEC1Z3
25 BGRIOUTH 14.00 SEC123
17 FEEDFORE 15.00 SEC1Z3

Total 177.00 - I
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Assignments

The fields in the decoder list:

Vid
Short for Valve Id. This depends on the selected decoder, which is selected in the Name field.

Name
The name of the decoder. When clicking in this field you'll get a list of all available decoders
as entered in Section 3.3.2, “Line Decoder” [page 30].

Capacity
Automatically read from the data available about the selected decoder.

Parent
The name of the parent sector. In this dialog, this will always be the same, since we're viewing
all decoders from one specific sector.

Description
Your description of this sector - up to 200 characters.

3.  When you're done editing the sector(s) to your liking, click the Exit button to save your configuration
and close the dialog.

@ Note
Once created, sectors can not be deleted.

To see a list of how all decoders are mapped to sectors, check out the next section, Section 4.6.1, “Listing
Decoder to Sector Assignments” [page 69].

4.6.1. Listing Decoder to Sector Assignments

To get an overview of which decoders are assigned to which sectors, follow this procedure:

e Open the Irrigation menu and select Sectors > Display all Decoders:
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Assignments

fi ProCom - TRAINING - [PACIFIC SHORES A - Controller, A]

Systemn BIGEEEREN Manual Setup View  Help

E!.l £ Irrigation Schedules | pre |
Seckors Display [ Modify Sectors
Purp Skatus
Sensor Wizard

Uzer Pasawd | Inst. Pasawd |

Display all Decoders

Sensor Skakus

TUCOR: INC.
DEMO

518 WALLACE ROAD
WERFORD

51090

P,

PROCOM 505"

Digplay all Decoders Off Line

This will bring up the list of decoders and their "parent" sectors (empty if the decoder isn't included in
any sectors):
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Pump Status

Display all Decode

i
Name Capacity | Parent

EDAREBRM 35.00 | SEC1Z3
EDARERS 30.00 SEC3
BDBGATE 27.00  SEC123
EDMASTER 35.00 SECZ
BEEDHYDRA 31.00 SECS
BEGRMORTH 15.00 SECZ
BGRIOUTH 14.00 SEC123
COBLEED 20.00 SEC123
CURBGR 23.00 SEC1Z3
DREED 24.00 SEC1Z3
DREEDBALC 5.00 SEC1Z3
DREEDFR 25.00 SEC3
DRCIR 5.00
DRGR 10,00 SEC123
FEEDFORE 18.00 SEC1Z23
FEEDFPORM. 31.00
FGORIPM 4.00

S Note
A decoder can only be included in one sector.

4.7. Pump Status

To check or edit the status of your pumps, follow this procedure:

1. Open the Irrigation menu and select Pump Status:
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Bl ProCom - TRAINING - [PACIFIC SHORES A - Controller A] H=E

Systemn BIGEEEREN Manual Setup View  Help

E g Irrigation Schedules

Seckors b

Sensor Wizard g

Sensor Skakus

E - User Paszawd | Inzt. Passwd |

TUCOR IMC,

DEMC
218 WALLACE ROAD
WERFORD
21090
pa,
EditMiew Pump status Off Line
This brings up the pump status dialog:
[ ) d L]
it
Pump Status | Capacity | Description -
1 Active 30.00 Wain pump on inlet
2 Active 30.00 Main pump on inlet
3 Active 15.00 Additional purmp on inlet
4 Active 15.00 Additional purnp on inlet
L Active 35.00 Booster on section 2
3] Active 35.00 Booster on section 1
7 Mot Installed 0.00
Total; 160.00
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Sensor Status

2. Now you can change the status and description of the pumps registered in the system. The pumps
listed are the ones that are entered when your physical system is described to the PROCOM software
- check Section 3.4.1, “Pump Decoders” [page 32] for more details on how to add pumps to the list.

The fields in this dialog are:

Pump
ID number of the pump. This is assigned automatically by the PROCOM.

Status
You can change the status between Active and Passive. Setting the status to Passive doesn't mean

that the controller forgets about the pump - it's just a guarantee that it will never get started. This
can come in handy if you need to take out a pump for repair etc.

@ Note
The third option in the Status list, Not Installed can not be chosen here - that is part of
the installation data and is handled in Section 3.4.1, “Pump Decoders” [page 32].

Capacity
The capacity entered when adding the pump to the system.

Description
Your own logical description of the pump.

3.  When you're done editing the pumps, click the Exit icon to save your settings and close the dialog.

4.8. Sensor Status

To check or edit the status of your sensors, follow this procedure:

1. Open the Irrigation menu and select Sensor status:
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Bl ProCom - TRAINING - [PACIFIC SHORES A - Controller A] H=E

Systemn BIGEEEREN Manual Setup View  Help

Eg Irrigation Schedules M - Uzer Pazzwd | Inat. Paszawd |
»

Seckors

Purp Skatus
Sensor Wizard

) : . TUCOR INC.
: ¢ i [ DEMC
SR £18WALLACE ROAD
PROCOM:soo o
500 51090
P,
Edit"iew Sensor status Off Line
This will bring up the Sensor Status dialog:
Cl -
e
Name Status ON OFF
* Line “oltage ™ Llzed
* Shart Circuit™ Llzed
* Hain Check ™ zed Wied May 18 15:13:15 2005
* Alarm Sensor®  Used Wied May 18 00:45:65 2005 Wed May 18 15:11:06 2005
Wa Wind Speed”  Used
WS Hain Limit* | Used
WS Temperatur® | Used
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Sensor Decoder Wizard

2 Important

When a sensor triggers an alarm, the ALARM LED on the controller will turn on and stay
lit until this dialog has been opened. Opening the dialog is the way you tell the PROCOM
that you have registered the event and that it's safe to turn off the LED.

2. The list of sensors are the ones that are configured in Section 3.5.1, “Sensor Inputs” [page 34]. What
you can edit here is the Status column that can be set to Used or Not used. There is a third option in
the list, Not Installed, but this can only be activated when setting up the physical system under installation
data. See Section 3.5.1, “Sensor Inputs” [page 34] for more details.

@ Note
The Line Voltage and Short Circuit sensors are built in and can not be de-activated as
these will notify you about problems with the two-wire path itself.

The ON and OFF columns show you when the sensors have last notified the PROCOM. In the example
above the alarm sensor was active on May 18. between 08:45:55 and 15:11:06. The rain sensor was
activated briefly after, at 15:13:15, and is still active.

What the notifications from the different sensors actually mean depends on how they are configured
(again, see Section 3.5.1, “Sensor Inputs” [page 34]).

3. When you're done editing the status of the sensors, click the Exit icon to save your settings and exit.

4.9. Sensor Decoder Wizard

The sensor decoder wizard is a tool that helps you define a set of actions to take in response to sensor
input. The wizard takes you through just four simple screens, and each screen has instructions on how to
answer the questions it asks you.

The Wizard let's you define two types of rules:

1. When a specific flow sensor exceeds a certain value, you can take action.

2. When the summed flow for a group of sensors exceeds a given value, you can take action too.

To create a rule set for how the PROCOM should react to input from your sensors, follow this procedure:

1. Open the Irrigation menu and select Sensor Wizard:
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fi ProCom - TRAINING - [PACIFIC SHORES A - Controller, A]

Systemn BIGEEEREN Manual Setup View  Help

E g Irrigation Schedules

Seckors b

E - User Paszawd | Inzt. Passwd |

Purp Skatus

Sensor Skakus t!

TUCOR: INC.
DEMO

518 WALLACE ROAD
WERFORD

51090

P,

PROCOM 505"

tart the Sensor Decoder Wizard for editing Alarms and Monitaring Off Line

This brings up the first screen of the Sensor Decoder Wizard:
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Sensor Decoder Wizard

Flow sensor wizard (v1.44b1) - [SIENNA]

Please choose the flow meters to be summed and displayed on the controller. The alarms set up in
this wizard will be bazed on this sum flow. If you need to repart your water consumption using the
logeiewer, please check “Use flow in logviewer™!

Inechuide in Sum Monitor data

W 1-[F51) [ Log flow bo file

W 2-[Fs2| W Logfiow to s

W 3-[F53) [ Log flow to fle

¥ 4. [F54] ¥ Log flow b Fle

[~ 5-[F55) [ Log fow to fle

[ B-[FS8) I~ Log flow to fie

[~ 7-[F57) [ Log fow to fls

[ Uz Flew iy boogvimsned
Piirk Preview | Nest > Cancel |

In this first step of the wizard you need to check which decoders will be included in "group” rules - you
must select which sensors can add to the summed up flow.

You also need to check which sensors should log their flow, and whether you want to see the flow in
the log viewer (see Section 4.12.2, “Offline Monitoring - The Log Viewer” [page 91] for more details).

@ Note
The wizard has Next and Back buttons that allows you to browse freely back and forth
between the screens and change the settings until you're happy with your choices.

In the next screen you enter limits for each flow sensor that will cause the running irrigation to be aborted
- irrigation will be picked up again when the next schedule kicks in. The unit is what ever was chosen
when configuring the PROCOM initially (see Section 3.1.1, “Parameters” [page 18] for details).

Beneath the list of sensors you can enter the limit for the summed up flow.

2 Important

This is the sum for the sensors checked in the previous screen - not the sum for all sensors
listed here.

Finally you can enter a pager number and message for each sensor and the summed flow - the pager
will then be notified if the limits are exceeded.
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@ Note
The PROCOM must have a modem connected in order for pagers to be notified.

Flow sensor wizard [v1.44b1) - [SIENNA]

Set the imit for the indvidual sensors andfor the sum flow. In case of an alarm, the currenily acive
vahve(s) will be shut down, and imgation will continue whenever some vabe is scheduled to start next.
You may enfer a pager number for the contraller to call in case of an alamm (Modem in contraller
required).

Lirmil Call 8, followed by massage
1-IF51] |

2-1rs2) |
3-[F53] |
4-F54 |
5-[F55] |
6-[Fs8] |
7-1Fs71 |

gl gl 8| g8 Bl sl 8

|
|
I
|
I
|
I

Sumemed fow | s |

Pt Freyiew <Back | Nea> | Gancel |

Flow sensors can also monitor flow between active irrigation schedules, which is an easy way to detect
leaks in your pipes. This next screen lets you define actions to take when the flow exceeds certain limits
with no irrigation going on.

You define the flow limit, which action to take and on which decoders - all for each sensor and for the
summed flow:
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Sensor Decoder Wizard

Flow sensor wizard {v1.44b1) - [SIENNA]

The controller is able to monitor the system between imgation and give an alam in the case of a leak.
Please spacify the actions for the indmidual sensors andfor the sumn flow in case of alarms. You may
enter a pager number for the controller to call in case of an alarm (Modem in controller raquired].
Achion Decodes Lirmil Call B, followed by
1-[F51] [Desctvate =] [202 = [ |
2-[Fs2] [Deactivare ~] [an x| | od |
3-1Fs3] | = [ of
4-fFsq) | | =]
5-1Fs5] | = = o
6-IFs6] | | =]
7-1Fs71 | = = of
Summed fiow | | e EN o |
Freyiew | < Back ] Hest > Cancel

2 Important
Regarding alarms on master valves: If your master valve is "normally open”, meaning that
it will shut down in the event of an alarm, you must remember to set the master valve's flow
capacity to zero, or else the PROCOM will register that a valve is running and needs water,
and it will start the pumps. This, of course, will lead to problems.

The last screen lets you take protective measures on behalf of your pump in case irrigation doesn't kick
in as it was supposed to (due to errors in the equipment in the field). Here you can enter a flow limit
that must be exceeded within 60 seconds from irrigation start - if this doesn't happen, the pump is shut
down.

This prevents your pump from working up a critical pressure in the pipes, or melting down the pump if
no water is flowing.
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Flow sensor wizard (v1.44b1) - [SIENNA]
In case imgation does not start you can protect your pump by entering a limit value. if flow does not

exceed thiz limit within B0 seconds, the pump is shut down. You may enter a pager numbear for the
controller to call in case of an alarm (Modam in controller required).

Lirit, weses 0 For clisable 0
Edlt,lulmu@dt&'ﬂmm.l

Freyiew | < Back Einish Cancel

4.10. Manual Control

In addition to completely automated operation, the PROCOM lets you intervene manually if you want to run
or stop a specific decoder or schedule. This section describes how you take manual control over the PROCOM
system.

c Important

To work with any procedure in this section you must be connected to the controller.

4.10.1. Controlling Decoders

Follow this procedure to take manual control over a single decoder:

1. Open the Manual menu and select Turn Decoder On/Off:
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Controlling Decoders

Swskern  Irrigation Setup  Wiew Help

Eg W B 5 5 Gyl A7 k _ Uszer Pazawd Inst. Passwd I
SinfOfF

Turn Irrigation Scheduls
Display running Decoders

Turn Decaoder On/Off manually |Dn Line MWeather st.)

2. Now the Manual Decoder Control appears:
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Start Stop Stpall
Dec. Control

Zelect Line Decoder Fun Time

1297 A |1n

1218
1219 Mintes

1221
1222
1223
1224 b

Imstructions
Start:

1. Select the Decoder
2. Enter Run Time in Minutes
3. Press Start to activate the Decader

Stop :

1. Select the Decodear

2. Press Stop to de-activate the Decoder
Mote: The connection to the Controller

must be active to manually StarkStop a
decoder

The dialog itself has the instructions for how to start or stop a decoder:

To start a decoder:
Select the decoder from the list, enter run time in minutes and push the Start button.

To stop a decoder:
Select the decoder from the list and push the Stop button.

3. When you start or stop decoders manually the communication status window will state that the software
is "Transferring miscellaneous data to/from the controller" as seen in this dialog:
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Controlling Irrigation Schedules

il Communication Status E|
| = S
{+ {

LB

Status
Tranzferring mizcellaneous data toffrom the controller
Messages
~
b
2] >

4. Now ifyou list all running decoders, you'll see any decoders you started manually (1220 in our example):

spla g Decode L]

e

Name Capacity | Parent Status il
119 48.00 Manual
122 48.00 hlanual
1220 16.00 Manual
Total 112.00

TI

The Status column tells you whether a decoder has been started manually (Manual) or as a part of an
irrigation schedule (Active).

4.10.2. Controlling Irrigation Schedules

Follow this procedure to start or stop an irrigation schedule manually:

1. Open the Manual menu and select Turn Irrigation Schedule On/Off:
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Swskern  Irrigation Setup  Wiew Help

Turn Irrigation Schedule CnjioFf

Eg Turn Decader On/off _ Uzer Pasawd Inst. Pasawd I
»

Display running Decoders

PROCOM:so0

otart of an Irrigation Schedule |Dn Line MWeather st.)

Now the Irrigation Schedule Control appears:
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Listing all Running Decoders

Start Stop
Irt. Contral

Select Irrigation Schedule

Z SHRUB .
LOTF

LOT 12

PARRING

PARKIRG2
PARKIMGS
PARKIMGE
PARKINGS b/

Imstructions
Start:

1. Select the Schedule
2. Press Start to activate the Schedule

Stop :
Fress Stop to stop any active Schedule
Mote: The connedtion to the Controller

must be active to manually StartStop
Schedules

The dialog holds the instructions itself: Select a schedule from the list and push the Start or Stop button.

3. After starting/stopping a schedule you'll get a confirmation:

ino X

L
\lr) Irrigation Schedule will start shorkh: \lj) Irrigation schedule will stop

In addition, when starting a schedule, you'll see its running decoders in the list of running decoders.

@ Note
It might be a little while before the alert pops up since the PROCOM acts only on "whole
minutes".

4.10.3. Listing all Running Decoders

In a complex system, a nice feature of the PROCOM is the possibility to check a list of all running decoders.
Follow this procedure to get to the list of running decoders:
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1. Open the Manual menu and select Display running Decoders:

i ProCom - SIENNA - [007 - SIENNA]

System  Irrigation BEEREEN Setup  View  Help

E@ Turn Decodsr OnfOFf _ User Passwd | Inst. Passwd I

Turn Irrigation Schedule QnfioFF
v running Decoders

Display running Decoders, bath manually started and schedule controlled | On Line (Weather st.)

2. Now the list of running decoders appears:

spla g Decode L]

e

Name Capacity | Parent Status il
119 48.00 Manual
1022 45.00 Fanual
1220 16.00 Manual
Total 112.00

TI

The window is all read-only, but here's the meaning of the different fields:
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Status

Name
The name provided for this decoder during setup (See Section 3.3.2, “Line Decoder” [page 30])

Capacity
The capacity is read from the type description of this particular decoder (See Section 3.3.1, “Types
of Valves” [page 29])

Parent
If this decoder is part of a sector, the sector name will be displayed here.

Status
One of Manual: started manually, or Active: running as part of an irrigation schedule.

@ Note
Decoders started automatically by an irrigation schedule will not show up when you open
the dialog - only decoders started after the dialog is opened will appear.

4.11. Status

Whenever you connect to a controller, the Status Window will pop up:

Irrigation status E

On Line MYeather st} Wed Feb 23 (2 00:17:35 2005

Irrigation Contral

| i | | @ | | @ |when |dle

Active schedule

schedule Remaining Remark

Time YWindow

Itrigation will be closed fram: 00:00 to: [00:00
Monitor

@ Tip
You can also open the Status Window manually: Open the View menu and select Status.

Here's a description of the four parts of the Status Window:
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Monitoring

Controller Status

The box next to the date in the top shows the controller status, which can be one of the following:

Status Message Description

Irrigation On Normal operations: schedules will be run according
to plan and the sensor decoder system is active.

Irrigation Off No schedules will be run according to plan and
sensor decoders are inactive.

Off line PC is not connected to a controller.

Calling (Weather St.)

Performing a call to the weather station.

On line (Weather St.)

Communicating with the weather station.

Exiting Weather St.

Disconnecting from the weather station.

Weather St. Alarm

Weather station is emitting an alarm.

Closed (Time Window)

Irrigation is halted because the time of day is in the
"Time Window" for irrigation shutdown.

SHORT (2-wire short)

The PROCOM has reported a short circuit on the
two-wire path.

ERROR (GND fault)

The PROCOM has reported a leak on the two-wire
path.

RAIN

The rain sensor is active.

ALARM (pump)

The alarm sensor is active - this is typically a pump.

Irrigation Control

&

Start Irrigation

Stop Irrigation

when |dle

Stop Irrigation when there is a break in the
scheduled runs.

Time Window
Here you can define a time window during which all irrigation will be blocked.

Monitor
This part of the Status Window will display the last monitor messages in three lines:

1. Line one will show the latest monitor data.
2. Line two will show the latest SUM flow.

3. Line three will show the latest alarm.

4.12. Monitoring

The PROCOM software lets you monitor everything the controller does. You can monitor events in real time
as well as view and analyze log files for previous days of irrigation.
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Online Monitoring

To perform any of the monitoring tasks described in this section, you must be connected to the controller.
4.12.1. Online Monitoring

Online monitoring allows you to keep an eye on the log file as it grows - you'll see the lines being appended
as the PROCOM carries out its actions.

Follow this procedure to call up the online monitor:

1. Open the View menu and select Monitor irrigation > Monitor Irrigation, Screen:

el ProCom - SIENNA - [007 - SIENNA]

Swstem  Irrigation Manual  Setup BYERS Help

ﬂg—lél Skatus Frmdiime | Treer Pasewd | Inst Passwd I

Manitot irrigation  # Maonitar Irrigation, Screen

Extract and wiew monitar log
Wigww monitor log
Extract monitar log

PROCOM 05"

show the Monitar [rrigation log view Irrigation Oin

2. Now the online monitor pops up:
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Online Monitoring

E_i ProCom - Monitoring

&t B

al

Irrigation status OLff Wed Febh 23 00:45:15 2005 L
* ALL * STOPPED Wed Feh 23 00:45:19 2005 o
Irrigation status On Wed Febh 23 00:45:21 2005

Irrigation status OLff Wed Febh 23 00:45:24 2005

0

* ALL * 3TOFPPED Wed Feh 23 00:45:26 2005 o
Irrigation status On Wed Febh 23 23:21:36 2005

w#%*% START L AT Wed Feh 23 23:25:03 2005 "
Fram: 200502, - Lines: 81 Maode: Append | Status: Heady I

Each line consists of four elements. For instance:
"LAWN STARTED Wed Feb 23 16:20:00 2005 60"
This line can be broken down like this:

LAWN
Identifier for what the controller is working on - a pump, a decoder, or as here, an irrigation schedule.

STARTED
Action taken, like started, stopped.

Wed Feb 23 16:20:00 2005
Time for log entry

60
Expected flow for this action.

In addition to the Exit icon, the online monitor has these icons in the top row:

Icon Description

ﬂ"ﬂ Copies the selected content to the clipboard. Before
clicking this you must use the mouse to highlight
the lines you wish to copy.

To get more complex extracts from the log, check
out Section 4.12.2.5, “Extracting Log
Files” [page 98].

Selects data from the previous day relative to the
one you are currently viewing.

-

Selects data from the next day relative to the one
you are currently viewing.

0

Selects data from today in append mode, which
means that you will see lines appending in the
window as the PROCOM does its job.

|

This is the default mode when you open the online
monitor.
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Offline Monitoring - The Log Viewer

4.12.2. Offline Monitoring - The Log Viewer

The Log viewer digests all of your monitor data offline and gives you a number of useful reports on irrigation,
water usage, alarms etc. The log viewer application is a complex set of macros for Microsoft Excel, which
means that in order to use the Log viewer, you must have Microsoft Excel installed. The default security
settings of Microsoft Excel will initially prevent you from running the log viewer - check out the following
section (Section 4.12.2.1, “Getting around Microsoft Excel security warnings” [page 91]) to work around
this.

4.12.2.1. Getting around Microsoft Excel security warnings

Depending on your security settings in Excel, you might get warning about running an "untrusted macro".
If your settings are very tight (security setting: high) you'll get a warning like this:

Microsoft Excel El

macros, change the security level to a lower setting {not recommended), or request the macros be signed by the author using a certificate issued by

Macros are disabled because the security level is set to High and a digitally signed Trusted Certificate is not attached to the macros, To run the
A’ a Certificate Authority,

l Hide Help <+ ] l Open in Help Window ]
A
You may encounter this error for the following reasons:
1. Macro security is set ko:
+  Very High and the application encounters a signed macro, but the macro was automatically disabled, Use the Following procedure to enable
the macro:
1. Select the Tools menu option and then select Macro and Security. In the resulting Security dialog, set the security level to High
by clicking the High radio button,
2. Close the file and any other inskances of the application currenthy running on the computer (close all applications that also use the
application you are currenthy running).
3. Open the file again and examine the certificate of trust details and set the Always trust macros from this publisher box if you
trust the certificate issued by the publisher,
4 CIic!{ the Ena_lhle button to allow the macra ko rur, ) ) o o o ) w

If your settings are more relaxed (security setting: medium), you'll see a warning like this one:

Security Warning §|

" \Program Files\ProComLogviewer, xls" contains macros,

Macros may contain viruses, It is usually safe ko disable macros, but if the
macros are legitimate, you might lose some functionality,

Disable Macros ] [ Enable Macros ] [ Mare Info

It's safe to trust the macros in Logvi ewer . xI s, SO we recommend that you set your security settings to
"medium" and then click the Enable Macros button whenever you use the log viewer.
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@ Note
We take no responsibility for incidents caused by other macros because of this recommendation.

4.12.2.2. Extracting and viewing Monitor Data

To get the latest monitor data from the PROCOM and inspect it in the Log Viewer, follow this procedure:

1. Connectthe PROCOM software to your controller to get the latest monitor data - instructions are found
in Section 4.4, “Communicating with Controllers” [page 45].
S Note
You can have monitor data from multiple sites merged in the same PROCOM installation
- they will simply show up as different sheets in the reports created by the log viewer.
2. Open the View menu and select Monitor irrigation > Extract and view monitor log:
il ProCom - [001 - SIENNA]
System  Irrigation Manual Setup BUEES Help
E@ Skatus _ Tlaar Pacaswd I
Manitot irrigation  # Manitor Irrigation, Screen
Extract and wiew monitar log
Wigww monitor log
Extract monitar log
g TLCOR INC.
' DEMC
i WAL ACE ROAD
PROCOM:so0 rcore
51080
P,
Extract and view monitor log On Line (Weather st}
3. This will make the PROCOM check for new data in the pool of monitor data:
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4,

Extracting ...

Extracting site '"COCO BAY! from 2006.04.21 13:59:15

Plegze wiait!

If no new data is found, you'll see a message like this:

Extract information E|

Make sure that monitor data are retrieved from the

i :| Mo data found in this kime period (see dialog behind),
ProCom controller and call this Funckion again.

................................

................................

2 Im portant
Make sure that you have actually transferred monitor data in step 1 - otherwise the PROCOM
will keep responding that no new data is found.

Now the PROCOM will start loading the data, appending it to the existing reports and creating the new
reports:

Progress

Loading raw data.. |

” 33%0

Progress

Appending data ko raw data-sheets,, ),

—
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Progress

Making overview-sheets,,

19%G
| —

5.  Now the log viewer is ready for inspection:

ET Microsoft Excel - Logwiewer. xls

PE] Fle Edt  Wew Insert Formar Teak  Deta  Widiw  bHep

DExET WEW T cammands T !

Aldb - I

Tucor Flowmaster Logviewer
Show overview

Show data

Show alarms
and errors

THEDR wevorser

Pasitian of {he

Logviewer-menu Currently handling data from: B COCO BAY
Tap = Last alarm or error reported:

Use the custom menu ta view tha overdew-shaet, data-shaes, Raw datz-shaet or Error-sheet, ML

Proceed to Section 4.12.2.4, “Log Viewer Report Types” [page 96] to learn more about the different
report types.

4.12.2.3.Viewing existing Monitor Data

To view the monitor data already on your PC, follow this procedure:

1. Open the View menu and select Monitor irrigation > View monitor log:
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Swsken

Irrigation  Manual

Setup

Help

<

PROCOMsos'

Skatus

Manitar Irrigation, Screen

Manitor irrigation  #

Extract and view monitar log
y nikor lag
Extract monitor log k

TUCOR INC.
DEMO

WALLACE ROAD
WEXFORD
51090

PA

Yiew monitar log

|DﬁLme

If this is the first time you view the monitor data on your PC, the PROCOM will start loading the data,
like described in Section 4.12.2.2, “Extracting and viewing Monitor Data” [page 92].

Now the log viewer is ready for inspection:

173-230-0001/B 95




Offline Monitoring - The Log Viewer

ET Microsoft Excel - Logwiewer. xls

PE] Fle Edt  Wew Insert Formar Teak  Deta  Widiw  bHep

DExET WEW T cammands T !

k'

AldE -
Tucor Flowmaster Logviewer
Show overview

Show data

Show alarms
and errors

THCOR =owoue

Pasitian of {he

Logviewer-menu Currently handling data from: B COCO BAY
Tap = Last alarm or error reported:

Use the custom menu ta view tha overdew-shaet, data-shaes, Raw datz-shaet or Error-sheet,

Type & question for help

MM

Proceed to Section 4.12.2.4, “Log Viewer Report Types” [page 96] to learn more about the different

report types.

4.12.2.4. Log Viewer Report Types

Once you have gathered your monitor data and fed them to the log viewer as described in Section 4.12.2.3,
“Viewing existing Monitor Data” [page 94] you're ready to start investigating the reports. Here's an overview
of what the different fields means in the reports:

@ Tip

You can navigate between the reports or return to the front page by using the view menu:

96
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Microsoft Excel - view. xls

(] Bl Edit  Wiew Insert

Formak

{ Exit = (Wiew = | Commands = |

4 Cverview-sheet

Drata-shest

alarms and Errors-sheet

R.aw Data-sheet

]
!

Frontpage .

Wy

2 schedules active

The Overview Report

Tools

This gives you a good idea of the overall state of irrigation in your system. Grouped by date, the following

fields describe the irrigation:

Field Description
Schedules Name of the run schedule.
@ Note

If you see schedule names like this:
"(unknown ID = 12)", it means that the
schedule has been deleted, but the
monitor data still contains entries for
the schedule. This is handy when
generating historical reports.

Start Start time of the schedule

Stop End time of the schedule

Run Time Total run time

Used Water used by schedule.

Estim. Estimated water usage.

Diff. Difference between estimate and actual usage.

The Data Report

This report gives you more detail on how schedules have been executed - you'll see start and stop times
for schedules, but in addition you'll see the start times for each valve in the schedule, and the report will
also tell you about alarms. The report is listed chronically by date, and the data fields are:

Field

Description

Alarm

If the event is an alarm, this field will hold the name
of the alarm. Examples:

e ** Short sensor **

173-230-0001/B 97



Offline Monitoring - The Log Viewer

Field

Description

* ** Ground sensor **

e ** Rain sensor **

Schedules If the event is a schedule starting or stopping, the
schedule name will be listed here. Again, an
"Unknown" schedule means that the schedule has
been deleted in the PROCOM.

On Time of the event.

Valves Valves involved in the event. If a schedule starts

five valves simultaneously, the will be listed next to
the start time.

The Alarms and Errors Report

If you want an isolated overview of all alerts emitted by the system, this report will give you that. The

fields in the report are pretty self-explanatory:

Field Description

Alarm type Examples:
« Valve error
» Ground sensor
* Rain sensor
e Short sensor
» Data error

Site Name of the site spawning the alert or error.
Obviously useful if you manage multiple sites from
the same PROCOM installation.

Description Description of the event.

Raw Data

This isn't really a report, but the raw data as received from the controller(s). This data is the source for
the other reports and is mainly here for debugging purposes.

4.12.2.5. Extracting Log Files

If you want to export log data or maybe manipulate the data in your own application, you can extract and
export a log file from a time span of choice by following this procedure:

1. Open the View menu and select Monitor irrigation > Extract monitor log:
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fei ProCom - SIENNA - [D01 - SIENNA]

System  Irrigation Manual  Setup BREEES Help

Elrlél Skatus _ TTaer Paaaswd I Inaet. Pasaswed I

Manitor irrigation  # Manitar Irrigation, Screen

Extract and wiew monitar log
Yiew monitor log
ct monitar log

BIG TREE, IMNC.
RUSS PROPHIT

3175 COUNTRY LAKES DRIVE
FORT MYERS

33803

FL

Extract monitor log STATAKT

2. Now the extract dialog pops up and prompts you for a number of things:
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Extract monitor data g
Dates Site
After Befare
g -
| 2005-02/m1 | 2008-02/23 * Selected Al

SIEMMA,

Data TESTZITET
TESTZITEZ

(" Selected o Al
Z 7
[+ [
[ I
[+ [
Sor b':." |Dﬂ'tl3 j
File

o Append O Replace |C:'I.D|:u:uments and SettingsClaus Browse

7

Here's how you fill in the various sections:

Dates
Enter the date range for which you wish to extract log data - including the dates you enter. The text
boxes work by just typing on top of the defaults - you won't be able to enter a date in the wrong
format.

Site
Choose All to include all sites or Selected to pick out the ones you wish to limit the log extract to.

Data
Choose All to include all types of data or Selected to define what you want to appear on each line
of the log extract.

File
Use the Browse button to decide where to save your log file and select whether to Append to it or
just Replace it. If you're creating a new file, these two options give the same result.

Click the OK button to save the log data to file - please note that it can take a while to extract the data.

Now you can use a spread sheet like Microsoft Excel™ to manipulate your log data.
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@ Tip
If you want to view the extracted log with the log viewer, you also have the option of
extracting and viewing log data in just one step. To do this, open the View menu and select
Monitor irrigation > Extract and view monitor log.

4.13. Weather Station
4.13.1. ET Values

You can view ET values for the last 14 days. These values tell you how the irrigation has been corrected
by a connected weather station.

To view the ET values for your system:

*  Open the Setup menu and select Weather Station > ET Values:

i ProCom - SIENNA - [007 - SIENNA]

System  Irrigation  Manual BEEENM Yiew  Help

E@ Installation Diata E _ User Passwed | Inst. Paseswd I
Date and Time
ET default value g

Passwiord

Weather Station  #

PROCOM 5o

Yiew or Manipulate the ET Walues Irrigation On

This will bring up the ET Settings dialog:
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[l ET Settings

Unit | Day of week ET Values | Drigin|
1 Wednesday (10) 0.00 | Default
1 Thur=sday (11) 0.00 | Default
1 Friday (12 0.00 | Default
1 Saturday (13 0.00 | Default
1 Sunday (14 0.00 | Default
1 Monday [ 1) 0.00 | Default
1 Tuesday [ 2] 0.00 | Default
1 Wednesday [ 3 0.00 | Default
1 Thursday | 4) 0.00 | Default
1 Friday [ 5] 0.00 | Default
1 Saturday | &) 0.00  Default
1 Sunday [ 7] 0.00 | Default
1 Monday =3 0.00  Default
1 Tuesday [ 9] 0.00 | Default
1 Wednesday (10) 0.00  Default

There is one entry for each day in the 14 day cycle that makes up irrigation schedules - the ET Values
column tells you how much the irrigation should be corrected, and the Origin column tells you what
determined the value.

The value for the next ET period is marked in red and can be entered manually.

Input Value [E

Erter ET %alue for the coming period

0.00)|

] Cancel |

The possible values for Origin are:

Default
No data received from weather station - default setting used.

WS/Man
Data received from weather station or entered manually
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4.13.2. ET default value

The ET default value dialog lets you set a few settings that will affect the way ET works. To manage the
settings:

*  Open the Setup menu and select Weather Station > ET default value:

fei ProCom - SIENNA - [D01 - SIENNA]

System  Irrigation  Manual BEEENM Yiew  Help

Date and Time

Passwiord

Eg Installation Crata }M _ Uszer Paszswd | Inst. Pasawd I

Weather Station  # ET walues

PROCOM 305"

Edit the default ET value and the ET Period Irrigation On

This will bring up the default value dialog:
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Get weather data

r

ET default value [‘S_<

@ Fact Set. |

Default ET value (inch) o.1ad
Max. ET per davy (inch) 5.00
Time for ET period to start W
Max water abzorption per hour (inch) .50

Default ET value (inch)

This value is used if no data was obtained from the weather station.

Max. ET per day (inch)

Defines a limit that the weather station can not exceed when correcting irrigation.

Time for ET period to start

Time of day when the ET period should start.

You should leave enough room for the controller to call the weather station and retrieve data before
starting it's ET period - typically one to two hours. So, if the weather station collects data between
00:00 and 23:59, set the ET period start to 02:00. (See Section 4.13.4, “Weather Station

Setup” [page 106] for instructions on how to set the weather station data collection period).

This diagram shows you how the weather station measurement periods (00:00 to 23:59) are used
to correct the following days irrigation between 02:00 and 01:59 - the buffer zone between 00:00
and 02:00 makes sure that data gets transferred from the weather station to the controller:

Controller ET

02:00 Correction Period

Time

Weather Station
Measurement Period

Max water absorption per hour (inch)

The maximum amount of water the soil can absorb - irrigation will never be corrected to exceed
this.

To reset the settings to factory values, click the Fact.Set. button.

4.13.3. Get weather data

You can get the latest data from a connected weather station in raw format:

Open the Setup menu and select Weather Station > Get weather data:
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Get weather data

System  Irrigation  Manual Wiew Help

Date and Time

Passwiord

ET walues

ET default value
X her data

Weather Station setup
Connection setup

TUCOR INC.
DEMO

WALLACE ROAD
WEXFORD

51090

PA

PROCOMsos'

|Retrieve data fram the Weather Station [rrigation On

This will bring up the Weather Data window, holding the current ET correction value next to the Modified
ETc field (in this case, 0.11):

173-230-0001/B 105



Weather Station Setup

Get weather data g
hodified ETe (inch) 0.11
Type Wednesday( 31 Tuesday [(2) Monday (1)
Meazurements: 14:15
Temperature (deg. F) 775 77,9 7E.0 780
Hygrometry %) 1g 1g 18 1&
wind speed (mph) 1.8 1.8 1.6 1.6
wind direction (deg) 2406 241.2 2412 241._2
Light radistion (Witnz2) Error Error Error Error
Rainfall (inch) o.o0 0.00 000 0._0oa
ET (inch) 0.04 o.11 0.11 n.11
24 hour precipitation:

0l:0a0 a.ao 13:00 o.oo

0z:00 a.ao 14:00 o.oo

0z: 00 a.ao 1E5:00 o.oo

0d4:00 0. oo le:00 o.ao

O&: oo o.ao 17:00 0. ao

0&:0a a.aa 1g8:00 o.ao et Dt

a7:oa0 a.ao 159:00 o.oo A

0g: 00 a.ao Z0:00 o.oo

0%: 00 a.ao Zzl:00 o.oo

1la: 00 a.ao ZZ:00 o.oo

11:00 a.ao z3:00 o.oo

1lz:00 0. oo oo: oo o.ao

The ETc value is calculated by taking the ET value from yesterday (in this case Wednesday) and
subtracting the fallen rain that day (in this case zero).

The four columns in the Measurements block represent the current data and averages for the three
previous days.

You can update the current data by pushing the Get Data button.

4.13.4. Weather Station Setup

To manage the settings of the weather station:

»  Open the Setup menu and select Weather Station > Weather Station setup:
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Weather Station Setup

System  Irrigation  Manual Wiew Help

Eg Installation Ciata M _ User Passwd | _

Date and Time

Passwiord

ET walues
ET defaulk value
et weather data

Connection setup

TUCOR INC.
DEMO

WALLACE ROAD
WEXFORD

51090

PA

PROCOMsos'

|E|:|it the Weather Station Setup [rrigation On

This will bring up the settings dialog:

@ ore
The many dimmed out fields stem from older versions of the software that supported weather
stations that needed more configuration - you can just ignore these.
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Weather Station setup X

Fact Set

Alarm thresholds:
bace. wind speed a0.00 {0 - 112 mph)
Waz:. precipitation 30.00 (0 -39inch)

Win. temperature -30.00 (-22 - 113 deg F)

Setup:

First transmission time [00:00 - 23:59)

Reporting interval (0000 - 24:007

Reset time ao:00 (0000 - 23:59)
Carrier detect timeout (zec.) (0 - 997
Transmission timeout (sec.) [1-99)

Prefix far external call [0-49)

Delay after prefix (sec.) [0-49)

RRRRERRIREEE

Geographical information

Latituce [0 = Jo " Jo [z +]

Longituce ID_“ |El_ |EI_ IE'

Elevation a (0 - 9999 feet)
Fact.Set.

Click this button to revert to factory settings.

Alarm thresholds:
If any of these limits are met, irrigation will be halted. Max. precipitation must be measured for three
consecutive minutes to avoid false alarms.

Setup:
The Reset time determines when in the data collection will be reset. This must be coordinated with
the controller's ET period (Check out Section 4.13.2, “ET default value” [page 103] for details).

Geographical information
This is used to correct the ET values.

4.13.5. Connection Setup

To configure how the controller communicates with the weather station:

»  Open the Setup menu and select Connection setup:
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System  Irrigation  Manual Wiew Help

Date and Time

Passwiord

ET walues

ET default value

Get weather data
Weather Station setup
Connection setup

TUCOR INC.
DEMO

WALLACE ROAD
WEXFORD

51090

PA

PROCOMsos'

Edit the Carmrmunication setup [rrigation On

This brings up the connection dialog:
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Connection Setup

Connection setup E
Connection Setup
COM port Baud rate Connection method
hodem connection
2400 Direct connection
4200
QE0o

Modem Setup Strings

Phone numkber |

Attertian | e+
Hamg g |
Intizlization | ATT
Setup: | ATED W1
Cal | ATOT

The COM port and Baud rate fields can not be changed, but you should select between Modem
connection and Direct connection. If you select Modem connection, you should fill in the Modem Setup
Strings section too.

To revert to factory defaults, click the Fact.Set. button.
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Chapter 5. Testing

The test suites that ship with the PROCOM are all explained within their dialogs - this section will guide you
to the tests, but read the test dialogs carefully before initiating any of them.

5.1. Manual Test

To open the manual test suite from the main window:

1. Open the Setup menu and select Installation Data:

[l ProCom - [Permanent 5taff - East Bay]
Swskem

S

Irrigation Manual BSEENEE Yiew Help

f%-l E - User Passwd | Inst. Passwd I

Passwiard
Test 3
Weather Station  #

TUCOR INC.
DEMO

518 WALLACE ROAD
VWEKF ORD

51000

P,

PROCOMso=

Start edit of Installation Data | Off Line

This will bring up the Installation data main menu.

2. Now open the Test menu and select Manual Test:
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Manual Test

E_i ProCom, - Installation

Setup  Pipes Walves Pumps Sensors BIEES
-
y S Advanced Test% l
-
=ection 1(500.0
MWain Pipefs00.0) 0
Section 2(500.0)
i
& *
Manual test functions

Now the suite of manual tests will open:

ProCom, Test Manual [‘5_<

Intro | Line Dec. I Pump Dec. | Shiort test | Lire Supwvesy

How to Use the Manual Test Functions

The different tests can be run individually.

Line Dec. “erfy response of decoders
IAddress/Connectiondcoil)

Pump Dec: “erfy response of Pump Decoders.
IAddress/Connection)Relay)

Short test: Set the controller in B0Hz operation to use

clampmeter to track overloading of two-wire.
Line Suney: Yiew System Status,

3. Read the following sections for instructions on each test.
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Line Decoder

5.1.1. Line Decoder

This lets you test a single line decoder in the field and view the results as either a graph or a list of

measurements.

5.1.1.1. Graph

1.

2.

3.

Enter the interval in miliseconds:

ProCom Test Manual

Irtro | Line Dec. | Pump Dec. | Short test | Line Survey

Manual, Graph

Manual Graph Intro

The manual graph

measures the inrush and
holding current for
decoder=s. The graph i=
bazed on 44 samples=.
Select interwval and
first decoder to he
s2tarted and then press
Start Decoder. Wait for

graph.

| Manual, List

Graph

Key intitne interyal in ms:

| 20

Decoder to Start with:

Start Decoder

Stop Test

X]

Select the decoder you wish to test:

Select Decoder &

101 A

103
104
201
202
203
204
301
302 v

ik | Cancel

Wait for the graph to pop up.
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Line Decoder

A successful test should look something like this, where you see high current during inrush, and then
a much lower holding current after the valve has been pulled open:

B ProCom Test |:| |§| |g|

Foom  Print  Show

A failed test on the other hand could look something like this:
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Line Decoder

M ProCom Test |Z| |E| |E|

Foom  Print  Show

Delay 0, mAD

5.1.1.2. List

@ Note
The results from any tests you run in this dialog are saved in a sub directory of your installation
called Test Dat a. The results will be saved as <decoder nane>. t xt . Subsequent tests of the same

decoder will be appended to the file.

1. Enter the interval in miliseconds:
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Line Decoder

ProCom Test Manual [‘5_<
Irtro | Line Dec. | Pump Dec. | Short test | Line Survey
Manual, Graph | Manual, List
Table
Hey intime interyal in ms: Decoder to Start with:
20 | ﬂ Start Decoder

2. Select the decoder you wish to test:

Select Decoder rz

101 A

103
104
201
202
203
204
301
302 -

. —

ik Cancel

3. Wait for the test data to get listed.

A successful test will look like this, with a high inrush current and then a constant, lower holding current:
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Pump Decoder

ProCom Test Manual E
Irtro | Line Dec. | Pump Dec. | Short test | Line Survey
Manual, Graph | Manual, List
Tahle

| I:l Start Decoder

Count = 44, Standby Current = 3+0, Decoder = TEST101 L
Oms= 3md 1im= &0%7mlb 2ims &58ml Lim=z &67mib
Tims 687Zmhb SLim= &77mi 11&fm= 1Z8mi 13Em=  S7mlb
155m=s  S5Z2mb 175m= 385wk 125m=  35mk 21lim= 35mi
E3Em=s  Zlmd ELEm= 30wl E7Em=s  3Zml 29Em=s  3Flmld
3lim=s  Flmd 23Lfm=  Flwd 2Lim=s  Flmd A7Ems  Flmd
39Lfm=s  30md 41fm=  Flml 43im=s  ZFlmld d5fm=s  30mlb
47fms 259wl 43fm=s  Slmk Slfim=s S0Omd 53fm= 30wl
EEEm=s  2lmd E7Em=  3Flmd E9fm=s  30mld E1Em= 30wl
£3Ems  F1lmd GLim=  Flmlb E7Ems  F0mlb £9Ems  30mh W

Whereas a failed test could look like this:

ProCom Test Manual E
Irtro | Line Dec. | Pump Dec. | Short test | Line Survey
Manual, Graph | Manual, List
Tahle

Start Decoder

' 1 =

Count = 44, Standby Current = 340, Decoder = zZ04 L
Oms= Smd lEm= Smd 2Ems= Smd EEms= Smd
TEms Sk SEm= Smd 1l&ms= Smd 12Em= Smh

15Em= Smd 17Em= Smh 13&m= Smd £21Em= Jmh
Z3tm= Smd zhim= Smi ZT7Em= Jmi Z9E5m= SJmi
31lEm= Smd 33Em= Smd F3ELfm= Smd 37E5m= Smd
39Lkm= Sk 4] fm= Smd d43km= Smd 45 fm= Smh
47 5m= Smd 49 tm= Smh Eltm= Smd LE3fm= Jmh
ELim= Smd E7Em= Smi E3tms= Jmi E1lEm= SJmi
£3fm= Smd &5 Lm= Smd &7km= Smd 59 5m= Zmd W

5.1.2. Pump Decoder

The Pump Decoder test is simply an on/off button for your pumps that can help you verify whether the
controller is communicating with your pumps:
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Pump Decoder

1. There's nothing to configure or select in the pump decoder test - simply push the Start Pump button.

ProCom Test Manual Pg

Irtro | Line Dec. I Pump Dec. | Short test | Line Survey

Pump Decoder Test Start Purmp

2. Now each pump decoder is turned on and off. Verify the sanity of your system by monitoring the pumps
as the test runs.

ProCom Test Manual Pg

Irtro | Line Dec. I Pump Dec. | Short test | Line Survey

Pump Decoder Test Start Pump

PUMF 1 STARTED £3:39:E51
PUTMF 1 STOPPED Zz3:40:15
STOPPED PUUMEP S Z3:-40:15
Last Decoder Tested
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Short Test

5.1.3. Short Test

Perform the Short Test to put the system in 50Hz mode which allows you to use a clampmeter to track down
shorts on the two-wire path.

ProCom Test Manual E
Irtro | Line Dec. | Pump Dec. | Short test | Line Survey
Line Short Test Run Test

By running the line will be put in S0Hz
mode and you can use your clamp meter
for tracking shorts on the line.

5.1.4. Line Survey

The Line Survey isn't really a test, but a real-time snapshot of the current and voltage on the line and to
ground.

@ Note
The Expected Current takes into consideration the different types of line decoders attached,
but not the sensor decoders.

173-230-0001/B 119



Advanced Test

ProCom Test Manual g

Imtro | Line Cec:. | Pump Dec. | Short test | Line Survey

Line Survey - [ Line Control Module Firmwware version 219 ]

(SR Current: Current to the lines
Actual Zwkh (caloulated and
Exp. Stdby A0md measured) .
Toltage: Toltage on the line.
Earth Ref: Ground woltage and
Yoltage current. [ Ground
25 &7 voltage shold be
negative) .

Earth References
“aoltage Currert

—Z. 2V Zmi

A few rules of thumb for this test dialog:
« If voltage is below 25V you should consider it a short. Typically the voltage should be over 30V.

» The Earth Reference voltage should be around -2V and the current a few mA. Currents over 70mA
indicates ground leaks. Note that the controller toggles between measuring on the two sockets, so it might
toggle between OK and not OK state if one wire has a leak and the other one doesn't.

» Expected current might be too low in case you have an attached decoder running fewer valves than it is
capable of. For example if a decoder capable of running six valves is running only five or fewer.

5.2. Advanced Test

To open the advanced test suite from the main window:

1. Open the Setup menu and select Installation Data:

120 173-230-0001/B



Advanced Test

fil ProCom - [Permanent Staff - East Bay]
Swskenm

Irrigation  Manual BSEWEES Wiew  Help

<

Password
Test ]
Weather Skation  »

Start edit of Installation Data

M E - Uzer Pasawd | Inst. Pazswd I
| Date and Time

PROCOM o=

TUCOR INC.
DEMO

518 WALLACE ROAD
WEXFORD

51090

PA

~ Off Line

This will bring up the Installation data main menu.

Now open the Test menu and select Advanced Test:
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Advanced Test

E_i ProCom, - Installation

Setup  Pipes Walves Pumps Sensors BIEES

E ’E Manual Test '

=ection 1(500.0

MWain Pipefs00.0)

Section 2(500.0)

<

Automatic test functions

|

|

54

Now the suite of advanced tests will open:

ProCom Test Advanced

Intro | LD Response I GF Solenoids | GF Signal

How to Use the Advanced Test Functions

You should conduct the tests in the order of the tabs, starting at the
left hand side. Any faults should be carrected befare doing next test.

LD Response:  “erify response of decoders.
IAddress/Connectiondcoil)

GF Salonoids:  Check Solenoids for current leakage to ground ™)
GF Signal: Check the two-wire lines far ground leakage.
LD Condition:  Check the electranics of the Decoders. ™)

*| After these tests you have to power down for at least 5 minutes.

%]

| LD Caondition

3. Read the following sections for instructions on each test.
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LD Response

5.2.1. LD Response

The LD Response test will test the line decoder response for each decoder in turn. It's basically an automated,
chained version of the manual line decoder test.

1. Gotothe LD Response tab and click the question mark to select the first decoder:

ProCom Test Advanced f'5__<

Irtro | LD Response | GF Solenoids | GF Signal | LD Condition

Lire Decoders, solenoid

Decoder to Start with: Fun Test

ﬂ

2. Select the first decoder to test and click OK:

Select Decoder rz

101 A

103
104
201
202
203
204
301
302 -

.

ik | Cancel

3.  Now the test will try to activate each decoder in turn. Only the failures will show up in the list - the three
measurement columns are standby, inrush and holding current:
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GF Solenoids

ProCom Test Advanced g

Irtro | LD Response | GF Solenoids | GF Signal | LD Condition

Lire Decoders, solenoid
Decoder to Start with:

TEST101

** TEST ZStarted ** ZOOE. 03.27 { 1) E2:-:30:33

Fun Test

** ERROR ** Decoder 1032 [(3LE538): ZmA Fmd 3wl
** ERROR ** Decoder 104 (35239 : SmA 3md Smi
** ERROER ** Decoder 201 [(35Z84): Smh Zmd Smi
** ERROR ** Decoder ZO0E (3EE2E) - SwA Zmd 3wl

** TEST terminated *+*

S Note
Decoder types that have resistance set to zero will be ignored in this test. Decoder type
resistance is handled in the installation data - check out the details in Section 3.3.1, “Types
of Valves” [page 29].

5.2.2. GF Solenoids
The GF Solenoids test checks for Ground Failures in the solenoids. The test will reprogram all decoders to
the address zero, run the selected test voltage on both outlets for five minutes and then try to activate each

decoder in turn. The ones with ground leaks will have kept the address zero and thus not activate after the
five minute wait.

@ Note
This test will take at least five minutes to complete.

1. Go to the GF Solenoids tab and click the question mark to select the decoder to test first:
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GF Solenoids

ProCom Test Advanced Pz

Irtro | LD Response IGF Solenoids | GF Signal | LD Condition

Ground Fault, solenoids

Decoder to Start with: Test Level Fun Test
ﬂ v 5y 25y T 35V

The Test Level must be set according to what you are looking for: Solenoids failing the 15V test are
severely damaged, whereas solenoids failing the 35V are having very small ground leaks that you may
get away with ignoring.

Select the decoder to test first and click OK:

Select Decoder E

101 A

103
104
201
202
203
204
301
302 v

ik | Cancel

Click Run Test to start the test.

Now you'll see a lot of Repr ogr amni ng decoder <xxx> flashing in the window as the controller reprograms
all your decoders. After that, the two-wire is shut down at the testing voltage and you'll see a count
down to when the controller will start activating the decoders.

Only failed decoders will show up in the list. The three measurements are standby, inrush and holding
currents:
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GF Signal

ProCom Test Advanced

| LD Response I GF Solenvids | GF Signal

Intro | LD condtion
Ground Fault, solenoids
Decoder to Start with: Test Lewvel Fun Test
TEST10 8y 28y [ 38W

RPeprogramming: DONE

** ERROR ** Decoder 1032
** ERROR ** Decoder 104
** ERROR ** Decoder 201

** TEST terminated **

Shutting dowm LINE (@ Z5.0W DC)
Please wait!
(Pemaining time: 0.00)

[3EE2598) SwA Zmd 3wl
[3EZ99) - ZmA Fmd 3wl
[35EE84) : SmA 3md Smi

3

5.2.3. GF Signal

This test measures any ground faults on the two-wire path.

1. Go to the GF Signal tab and click Run Test:

ProCom Test Advanced

Irtro

Ground Fault, signal

Fun Test

| LD Response I GF Solenoids | GF Signal | LD Condition

x|

2. The results will show up in the window below. A successful test will look like this:
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LD Condition

ProCom Test Advanced E

Irtro | LD Response I GF Solenoids | GF Signal | LD Condition

Ground Fault, signal

Fun Test ‘

** TEST Btarted ** Z0O05_03.27 { 1) ZZ:EL:Z5
** TEST terminated *+*

Failures will be reported with expected and actual current.

5.2.4. LD Condition

This test will check for electrical failures in the line decoders. It reprograms all decoders to a common switch
code, turns off the two-wire path for a minute and then tries to activate each decoder without sending a
switch code. If a decoder has an abnormal power consumption it will have lost it's switch code during the
one minute power down and not react.

2 Important
Decoders that fail this test should be replaced.

1. Go to the LD Condition tab and click the question mark to select the first decoder to test:
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LD Condition

ProCom Test Advanced f'5__<

Irtro | LD Response I GF Solenoids | GF Signal | LD Condition

Lire Decaders, tharough

Decoder to Start with: Fun Test

d

2. Select a decoder and click OK:

Select Decoder rz

101

[

103
104
201
202
203
204
301
302 -

. —

ik Cancel

3. Click Run Test to start the test.

Now wait for all decoders to be reprogrammed and watch the count down before the controller tries
activating each decoder in turn.

Only decoders failing the test will show up in the list.
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LD Condition

ProCom Test Advanced a

Irtro | LD Response I GF Solenoids | GF Signal

Lire Decaders, tharough

| LD Condition

Decoder to Start with: Fun Test
TEST101
RPeprogramming: DONE
Shutting dowm LINE
Please wait!
(Pemaining time: 0.00)
*+ ERRBOR *+* Decoder 103 [3EE2598) SmA 3md 3wl
** ERRBOR ** Decoder 104 [3EZ99) - SmA 3md 3wl
** ERRBOR ** Decoder z0O1 [35EE84) : SmA 3md Smld
** TEST terminated **
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Chapter 6. Miscellaneous
6.1. Upgrading the Controller Firmware

Every time you upgrade the PROCOM software, you should transfer the accompanying firmware to the
controller too to ensure that the two are in sync. To upgrade the firmware, follow this procedure:

1.

c Im portant
You must be directly connected to the controller via one of your PC's COM ports. You can
not upgrade the firmware over a modem connection.

Make sure that you have chosen the right COM port for transferring the firmware: Open the System
menu, select Select COM Port and choose your port of choice:

The COM Port zelected here iz uzed for transfer of the CU (Central Linit)
software.

Zelect Service ComPort
COMT - Communications Port (Standard port types)

COME - Kevspan =B Serial Port (Keyspan)

COMS - CP2101 USB to UART Bridge Controller (Silicon Laboratories)
CoMa - PO Communications Port (Enhanced ports)

COM3 - UZB4o-Zerial Port Driver (MosChip Semiconductor Technology)
COMA O - Yirual IR COM Port (Jan Kiszka)

COM1T - USB-o-Zerial Port Driver (MosChip Semiconductor Technology)
COh 2 - ATEM USE to Serial Bridge (ATEN)

0 R e R

2 e P

Transfer of the hex file iz only possible with a direct connection.

2. Open the System menu and select Download CU Software (CU is short for Central Unit, which is an
alias for the controller):
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Upgrading the Controller Firmware

fei ProCom - SIENNA - [D01 - SIENNA]

S Irrigation Manual  Setup View  Help

Select sike E _ Uzer Pazzwd | Inst. Passwd I

Phone book,
Select COM Part

Downlaad

Exxit

Download software to contraller Irrigation Off

3. Inthe file chooser that pops up, select the firmware file - usually located in the directory in which you
installed the application. The file will typically have a .hex suffix:
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Upgrading the Controller Firmware

Open Central Unit Program, File

Lok it |l.f} PraCarn j = i e

L @ Bitraps
L"E§ ICen_Us
My Recent |5 TestData
Documents PraCam.hex

ky Computer
% File narme: |F'ru:uE-:um.he:-: j Open |
by Metwork,  Files of type: |Files [ be] j Cancel
Placesz

| Open as read-only

Click Open to continue.

4. Now the actual installation is about to begin. Depending on whether you are already online with the
controller, you'll see one of these two dialogs:

If you're online already If you're not online

Message [‘5—(| Message b—q

-, Download Ready: &, Download Ready:
\l‘) 13 Press OF J‘) 11 Press OF
23 Turn OFF the Central Unit 23 Turn QN the Central Unit

@ Note
If the controller is turned on, but you are not connected to it, you must:
1. Turn off the controller.
2. Click OK on the dialog shown above.

3. Turn the controller back on.
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Upgrading the Controller Firmware

5. Now the PROCOM will establish a connection to the controller via the COM port you have specified
and start transferring the firmware to the controller:

& ProCom Program Download |Z| |E| rz|

s
OK! Communication established!
Downloading Program

Expected time: 9:03

Time used: 0:13 [424])

6. When the installation moves on to the next step, there is no way back - the old firmware is wiped out
and the new is put in place. Finally the controller will flash eight times and then you're ready to go:
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Backing up your Installation

& ProCom Program Download

s
OK! Communication established!
Downloading Program

Expected time: 9:03

Time used:  8:38 [97%)

Clearing Flash [expected time: 1:30]
OK! Communication established!
Flashing 8 times ... [8]

Starting Program

Program is now Running

Download OK!

Push the On-fOffline buttons to reconnect!

If anything fails during this procedure, you should reboot your machine and try over.

6.2. Backing up your Installation

You should back up your data regularly in order to avoid re-entering everything if you computer crashes.
To back up a PROCOM installation, simply copy these files from the installation directory to a backup disk:

* procom | db
* monitor.ldb
* ProconRMS. i ni

You can also use these files to set up a second PC with your PROCOM software - just do a fresh installation
and dump these files into the installation directory and you're all set.
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Appendix A. Troubleshooting

A.l. Troubleshooting the connection

A general note on the connection between the PROCOM software and a controller: the timeout is relatively
high - in some contexts up to five minutes, so troubleshooting the connection requires a certain amount of
patience.

The PROCOM determines whether to try to connect to a modem or via a COM port by looking at the first
three characters of the number in the phone book. If these are "COM", it will try connecting via a COM port
- otherwise it will try to get a dial tone and connect via modem.

Check out the following two sections for what to keep in mind in each case.

A.1.1. When connecting via a COM port

Here's a list of things that you should consider when troubleshooting a direct connection using a COM port:
* The PROCOM supports COM ports 1-40 only.
» Make sure you're actually using the COM port you have entered in the phone book.

» The COM port you're trying to use can be occupied by another application running in the background. An
often seen example of this is Palm™'s Hot Sync application.

* If you're using a USB/COM adapter this in itself can cause problems, as such adapters don't always use
the same COM port between reboots. The only adapter that has been tested and is known to work for
sure is Keyspan USA-19HS.

A.1.2. When connecting via modem
» Make sure that there is a modem in both the PC you're using and the PROCOM you're trying to reach.

* When the PROCOM boots it will try to detect a modem. If it is successful, the the power LED will start
flashing - if the LED stays solid red the PROCOM has not reckognized any connected modems.

« It can take up to five minutes after the PROCOM starts until you can communicate with the modem, so
don't try to connect right away.

» The modem on the PROCOM can be busy - listen to the dial tone.
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Appendix B. Switch Codes

The format of switch codes is as follows:
<G oup><Cont rol ><I nrush vol tage><I nrush ti ne><Hol di ng vol t age><Hol di ng ti ne>.
The meaning of the different parts is:

Group
Determines the type of device that should react to a broadcast stop commands. Possible values are:

» 3: Non-irrigation device
* 4: Pump
+ 5:Valve

Control
Determines the range of the holding voltage. Possible values are:

* 9:Low range
» B: High range
This is normally set to 9.

Inrush voltage
Determines the voltage during inrush, when devices are started. Possible values are in a range from
2-9, A-F and 0-1 as listed in the table below. 2 is the lowest and 1 is the highest value.

This is normally set to F.

Inrush time
Determines the duration of the inrush pulse, measured in chunks of 10 miliseconds, so 3 equals 30ms,
4 is 40ms etc. Possible values range from 3-9 and A-F, where A-F corresponds to 10-15, so A is 100ms,
B is 110ms and the maximum is F, which means 150ms.

@ Note
If the resistance for the solenoid is between 1 and 50 ohms, the controller needs at least
100ms to measure correctly, and inrush times set lower than 100ms will be overruled by
the controller.

This is normally set to 3. If your valves won't get pulled open, try increasing the value.

Holding voltage
Determines the holding voltage. This is the current that must be applied after the inrush. Possible values
are in a range from 2-9, A-F and 0-1 as listed in the table below. 2 is the lowest and 1 is the highest
value.

This is normally set to 5. If your valves keep shutting off, try increasing this.
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@ Note
Increasing the holding voltage "takes voltage from the rest of the system" and you may end
up reducing the capacity of simultaneously running valves.

Holding time
This is almost always set to 0.

The table below shows the minimum holding voltage on the decoder output at a two-wire line voltage input
of 25V (normally 35V). The output will increase when the two-wire voltage increase. If voltage exceeds 27V
the output voltage will be adjusted to avoid unnecessary power usage.

Holding Voltage
Voltage select (5th digit) Low range (2nd digit setto 9) | High range (2nd digit set to B)
2 0,6 10,1
3 1,6 10,7
4 1,7 11,3
5 2,3 11,8
6 2,9 12,4
7 3,5 13,0
8 4,0 13,6
9 4,6 141
A 5,2 14,7
B 5,8 15,3
C 6,3 15,9
D 6,9 16,4
E 7.5 17,0
F 8,1 17,6
0 9,0 18,2
1 9,5 18,8
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Appendix C. AM/PM to Military time
conversion

AM/PM Military Time
12:00 Midnight 00:00
01:00 AM 01:00
02:00 AM 02:00
03:00 AM 03:00
04:00 AM 04:00
05:00 AM 05:00
06:00 AM 06:00
07:00 AM 07:00
08:00 AM 08:00
09:00 AM 09:00
10:00 AM 10:00
11:00 AM 11:00
12:00 Noon 12:00
01:00 PM 13:00
02:00 PM 14:00
03:00 PM 15:00
04:00 PM 16:00
05:00 PM 17:00
06:00 PM 18:00
07:00 PM 19:00
08:00 PM 20:00
09:00 PM 21:00
10:00 PM 22:00
11:00 PM 23:00
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